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Notice Every effort was made to ensure that the information in this document 
was accurate at the time of printing. However, information is subject to 
change without notice, and JDSU reserves the right to provide an 
addendum to this document with information not available at the time that 
this document was created.

Copyright © Copyright 2008 JDSU, LLC. All rights reserved. JDSU, Enabling 
Broadband and Optical Innovation, and its logo are trademarks of JDSU, 
LLC. All other trademarks and registered trademarks are the property of 
their respective owners. No part of this guide may be reproduced or 
transmitted electronically or otherwise without written permission of the 
publisher.

Trademarks JDSU and MTS/T-BERD 4000 are trademarks or registered trademarks 
of JDSU in the United States and/or other countries.

Microsoft, Windows, Windows CE, Windows NT, and Microsoft Internet 
Explorer are either trademarks or registered trademarks of Microsoft 
Corporation in the United States and/or other countries.

Netscape Navigator is a trademark or registered trademark  of Netscape 
Communications Corporation in the United States and other countries.

Ordering
information

This guide is a product of JDSU's Technical Information Development 
Department, issued as part of the User Manual.

WEEE Directive
Compliance

JDSU has established processes in compliance with the Waste Electrical 
and Electronic Equipment (WEEE) Directive, 2002/96/EC.

This product should not be disposed of as unsorted municipal waste and 
should be collected separately and disposed of according to your 
national regulations. In the European Union, all equipment purchased 
from JDSU after 2005-08-13 can be returned for disposal at the end of 
its useful life. JDSU will ensure that all waste equipment returned is 
reused, recycled, or disposed of in an environmentally friendly manner, 
and in compliance with all applicable national and international waste 
legislation.

It is the responsibility of the equipment owner to return the equipment to 
JDSU for appropriate disposal. If the equipment was imported by a 
reseller whose name or logo is marked on the equipment, then the owner 
should return the equipment directly to the reseller.
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Instructions for returning waste equipment to JDSU can be found in the 
Environmental section of JDSU’s web site at www.jdsu.com. If you have 
questions concerning disposal of your equipment, contact JDSU’s 
WEEE Program Management team at WEEE.EMEA@jdsu.com.
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About This Guide
The MTS/T-BERD 4000 of JDSU provides a portable, modular platform 
designed for the construction, validation and maintenance of FTTx 
networks.

The topics discussed in this chapter are as follows:

– “Purpose and scope” on page xii
– “Assumptions” on page xii
– “Technical assistance” on page xii
– “Technical assistance” on page xii
– “Conventions” on page xiii
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Purpose and scope
The purpose of this guide is to help you successfully use the MTS/T-
BERD 4000 features and capabilities. This guide includes task-based 
instructions that describe how to install, configure, use, and troubleshoot 
the MTS/T-BERD 4000 with modules.

Assumptions
This guide is intended for novice, intermediate, and experienced users 
who want to use the MTS/T-BERD 4000 effectively and efficiently. We 
are assuming that you have basic computer and mouse/track ball expe-
rience and are familiar with basic telecommunication concepts and termi-
nology.

Technical assistance 
If you need assistance or have questions related to the use of this 
product, call or e-mail JDSU’s Technical Assistance Center for customer 
support.

Table 1 Technical assistance centers

Region Phone Number

Americas
Telecom Products

866 228 3762
World Wide: 301 353 1550

tac@jdsu.com

Europe, Africa, and 
Mid-East

+49 (0) 7121 86 1345
(Europe)

hotline.europe@jdsu.com

+33 (0) 1 30 81 50 60
(JDSU France)

support.france@jdsu.com

Asia and the Pacific
Southeast Asia, Aus-
tralia, and New Zea-
land

+852 2892 0990
(Hong Kong)

+86 10 6833 7477
(Beijing-China)

All others 866 228 3762 tac@jdsu.com
xii User Manual 770000102/01
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During off-hours, you can request assistance by doing one of the 
following:

– leave a voice mail message at the Technical Assistance number in 
your region

– e-mail North American Technical Assistance Center, tac@jdsu.com, 
or European Technical Assistance Center, support.uk@jdsu.com

– submit your question using our online Technical Assistance Request 
form at www.jdsu.com.

Recycling Information
JDSU recommends that customers dispose of their instruments and 
peripherals in an environnmentally sound manner. Potential methods 
include reuse of parts or whole products and recycling of products 
components, and/or materials.

Waste Electrical and electronic Equipment (WEEE) Directive
In the European Union, this label indicates that this product should not 
be disposed of with household waste. Il should be deposited at an appro-
priate facility to enable recovery and recycling.

Conventions
This guide uses naming conventions and symbols, as described in the 
following tables.

Table 2 Typographical conventions

Description Example

User interface actions appear in 
this typeface.

On the Status bar, click Start.

Buttons or switches that you 
press on a unit appear in this 
TYPEFACE.

Press the ON switch

Code and output messages 
appear in this typeface.

All results okay
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Table 4 Symbol conventions

Text you must type exactly as 
shown appears in this type-
face.

Type: a:\set.exe in the dia-
log box

Variables appear in this type-
face.

Type the new hostname.

Book references appear in this 
typeface. 

Refer to Newton’s Telecom 
Dictionary

A vertical bar | means “or”: only 
one option can appear in a sin-
gle command.

platform [a|b|e]

Square brackets [ ] indicate an 
optional argument.

login [platform name]

Slanted brackets < > group 
required arguments.

<password>

Table 3 Keyboard and menu conventions 

Description Example

A plus sign +  indicates simulta-
neous keystrokes.

Press Ctrl+s

A comma indicates consecutive 
key strokes.

Press Alt+f,s

A slanted bracket indicates 
choosing a submenu from 
menu.

On the menu bar, click 
Start > Program Files.

Table 2 Typographical conventions (Continued)

Description Example

This symbol represents a general hazard.
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Table 5 Safety definitions

This symbol represents a risk of electrical shock.

NOTE
This symbol represents a Note indicating related information or tip.

This symbol, located on the equipment or its packaging 
indicates that the equipment must not be disposed of in a land-
fill site or as municipal waste, and should be disposed of 
according to your national regulations.

WARNING
Indicates a potentially hazardous situation which, if not avoided, could 
result in death or serious injury.

CAUTION
Indicates a potentially hazardous situation which, if not avoided, may 
result in minor or moderate injury.
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Chapter 1 Principle of Measurement
1

This chapter gives the principles of the measurements made by the 
reflectometer (OTDR) modules.

The topics discussed in this chapter are as follows:

– “Principle of reflectometry measurements” on page 2
User Manual 770000102/01 1
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Principle of reflectometry measurements
Optical time domain reflectometry consists in injecting a light pulse into 
one end of the optical fiber to be analyzed and observing, at the same 
end, the optical intensity passing through the fiber in the opposite direc-
tion to the propagation of the pulse.
The signal detected is exponentially diminishing in form, typical of the 
phenomenon of backscattering, with superimposed peaks due to reflec-
tions from the ends of the fiber or other variations in the refractive index.

Information
yielded by the
measurement

From a backscatter trace it is possible, in particular, to determine the 
position of a section of fiber within a link. The measurement result must 
reveal: 

– the attenuation
– the location of faults, by their distance from a point of origin,
– attenuation with respect to distance (dB/km)
– the reflectance of a reflective event or a link.

Fig. 1 Trace showing typical backscattering

To locate faults, a reflectometer measures only time. Consequently, 
group velocity must be introduced in order to determine the distance 
of the location. This is done by introducing the refractive index of the 
fiber into the instrument.
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Validity of
Measurement

UTI-T, in recommendations G.650, G.651 and G.652, give backscatter 
measurement as an alternative method for measuring attenuation, the 
method of reference being the cut fiber.

The field of application of backscatter is not limited, but the conditions for 
application of this method are nevertheless stipulated:

– injection conditions: Fresnel reflections must be limited at fiber input.
– a high-power source (laser) should be used.
– receiver bandwidth should be chosen to achieve a compromise 

between pulse rise time and noise level.
– backscatter power should be represented on a logarithmic scale.

Reflectance Reflectance is a value with which the coefficient of reflection of a 
reflecting optical element can be quantified. It is defined as the ratio of 
the power reflected by the element over the incident power.

These reflections are due to variations in refractive index all along the 
optical link in certain telecommunications applications. If they are not 
controlled, they may degrade the performance of the system by 
perturbing the operation of the emitting laser (especially DFB lasers) or 
may generate interference noise in the receiver by multiple reflections.

The reflectometer is particularly well suited to the measurement of 
discrete reflectances on an optical fiber link. To calculate the coefficient 
of reflection, it is necessary to measure the total amplitude of the Fresnel 
reflection generated and then to apply a conversion formula to obtain the 
reflectance value.

This formula takes into account:

– the total amplitude of the reflection measured by the reflectometer.
– the pulse width used to measure the amplitude of the reflection (in 

nanoseconds) 
– the backscatter coefficient of the fiber used:
– typical values of the backscatter coefficient for a pulse of 1 ns and

- for a single-mode fiber:-79 dB to 1310 nm
-81 dB to 1550 nm and 1625 nm
- for a multi-mode fiber:-70 dB to 850 nm
-75 dB to 1300 nm
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NOTE
To measure the widest range of reflection coefficient, it is necessary 
to insert a variable optical attenuator between the reflectometer and 
the link to be tested. This attenuator enables the level of the trace to 
be adjusted so as to avoid saturation of the reflectometer by the 
reflection to be evaluated.
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Chapter 2 Starting up
2

The topics discussed in this chapter are as follows:

– “Universal connectors and adapters” on page 6
– “Installing a new version of the software” on page 7
User Manual 770000102/01 5
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Universal connectors and adapters
Fiber Optic modules may be equipped with a universal connector and 
adapter selected at time of order.

Adapter types JDSU offers 5 different adapters, all compatible with this connector, 
allowing the user to switch from one adapter to another according to 
which fiber type he intends to work with.

Adapter types supplied are : FC, SC, DIN, ST and LC.

Switching
adapter type

In order to switch from an adapter to another, proceed as shown.

Fig. 2 5 different types of adapters may be mounted on the 
universal connector

FC Adapter (EUFCAD)

DIN Adapter (EUDINAD)

LC Adapter (EULCAD)

ST Adapter (EUSTAD)

SC Adapter (EUSCAD)

PC or APC Connector

Fig. 3 Removing and refitting an adapter

Pull out in the direction of the 
arrow in order to release the 
adapter from the lug holes

To place an adapter, position the 
handle as shown in order to 
engage with the the lugs, push 
hard and pull the handle down
6 User Manual 770000102/01
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Cleaning the
universal

connector

Remove the adapter in order to access the ferrule and clean it using a 
cotton swab.

Installing a new version of the software

Where and how
to obtain the

new software

The new version of the software can either be procured on a storage 
medium (CD-ROM, USB stick memory or CompactFlash memory card) 
from your JDSU Customer Service, or can be downloaded from JDSU’s 
internet site: www.jdsu.com.

Downloading
from Internet

When the software is obtained from the Internet, it must be saved on a 
storage medium before the software upgrade of the product can be 
carried out. To do this, on the JDSU web site

1 Open the page of the product concerned: MTS 4000 or T-BERD 
4000 Multiple Services Test Platform

2 Click on the tab Downloads.

3 Click on the link 4000 Firmware Update
A new page opens explaining the process

4 Follow the instructions to download the exe or jds file and update 
the Base Unit.

When a new software version is loaded, there is a risk of re-initializa-
tion of the internal memory. Before installing the new software, it is 
therefore advisable to to save the results in the memory, using the 
Save function in the Memory menu called up by the FILE button.

Do not interrupt the installation process, as this could damage the 
instrument.

To avoid any interruption of the installation procedure, the Base Unit 
must be operating on the mains: if the procedure is started while oper-
ating on battery, a message indicates that the instrument must be 
connected to the mains.
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Installation
from the

harddisk of a
PC

1 Connect the MTS / T-BERD into mains with the AC plug, and switch 
it on.

2 Connect the MTS / T-BERD to the PC by an Ethernet link

3 On the PC, download and save the .exe upgrade from the web 
(www.jdsu.com)

4 Once the transfer is completed, and in order to perform the upgrade, 
the «.exe» file shall be extracted under a root of the PC. The files 
extracted shall be placed under C:\ or under a drive created with the 
following process: 

a Put the release under a directory, such as 
C:\4000_Base_Upgrade:\

b Open a DOS console, by selecting Windows > Start (bottom 
right of the PC screen) > All programs > Accessories > 
Command prompt.

c Then type the command subst N: C:\4000_Base_Upgrade\ 

d Close the DOS console.
This command will create a virtual drive N: (N: is an example)1

5 Go to the driver, using Windows Explorer

NOTE
The jds file must be downloaded if you cannot load the exe file. Once 
donwloaded on your PC, the extension «.jds» must be changed to 
«.exe».

NOTE
Use a cross over if the Base Unit is directly connected to the PC or a  
direct cable if the Base Unit is connected to the LAN.

If the file «.jds» has been downloaded, once on the PC, convert it 
in «.exe».

1."N:" may be replaced by another letter if necessary and "4000_Base_Upgrade"
corresponds to the directory where the upgrade files have been unzipped.
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6 Double click on the .exe file: A window called "Winzip self extractor", 
will appear. Check that the folder is correct i.e. the C:\ drive or the 
newly created N:\ drive is appearing "Name:\" then press “Extract”. If 
not, click on ”Browse” in order to select the right drive, then click on 
"Extract”.

The message "All files extracted ok" is displayed and invites you to 
click on OK.  

7 Press OK. 

8 Run TFTPD32.exe: note the «Server Interfaces» address which 
appears in the TFTPD32 window.
Note: TFTPD32.exe is one of the extracted files

9 Run FTP server.exe. An error message will appear: click on OK.
Note: FTPServer.exe  is one of the extracted files
The window «Pablo’s FTP server» is displayed. Click on the green 
arrow (or select menu File > Start).

10 On the Base Unit, press the HOME key, then System Settings: in 
Utility > Upgrade Parameters > Server Name, enter the IP 
address previously noted (see "8" above). 

11 Quit the System Settings menu and then press, in succession, 
Expert Tools > Upgrades > Software Upgrade > Upgrade via 
Ethernet.
The message «Verify IP address of PC server» appears. 

12 Click on Continue.
The list of the software versions available on the PC is displayed 
next to the versions installed on the Base Unit.

Fig. 4 WinZip Self Extractor

More recent version on the PC than on the Base Unit

Less recent version on the PC than on the Base Unit

Identical version on the PC and on the Base Unit
User Manual 770000102/01 9
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13 Click on Show Prev. choice or Show Next Choice to display the 
previous and next versions available.

14 Click on Confirm this Choice to start the upgrade of the selected 
software(s).
or
Click on Confirm All Choices to upgrade all versions.

Upgrading begins. The Base Unit is automatically rebooted. 
Upgrading takes several minutes. At the end, the Base Unit is auto-
matically restarted.

15 On the PC, close the 2 windows opened to perform the installation.

16 Once the upgrade is completed, you may remove the virtual drive (in 
our example "N:") by using the command subst N: /d.

Installation
from Ethernet

Before starting the software upgrade via Ethernet, make sure the IP 
adress of the PC server.

1 Press, in succession, Expert Tools > Upgrades > Software 
Upgrades > Upgrade via Ethernet.
The message Verify IP address of PC server appears. 

2 Click on Continue. 
The list of the software versions available on the PC is displayed 
next to the versions installed on the Base Unit.

3 Click on Show Prev. choice or Show Next Choice to display the 
previous and next versions available.

4 Click on Confirm this Choice to start the upgrade of the selected 
software(s).
or
Click on Confirm All Choices to upgrade all versions.

NOTE
The software versions list does not always appear (cf previous ver-
sions) as well as the Show Previous / Next Choice buttons and the 
Confirm/Continue key. In this case, the upgrading starts automati-
cally.

During the upgrade, the Testing indicator is lit in red. Do not 
push any button while the indicator is lit.
10 User Manual 770000102/01
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Upgrading begins. The Base Unit is automatically rebooted. 
Upgrading takes several minutes. At the end, the MTS/T-BERD 
4000 is automatically restarted.

Installation
from a USB

memory stick

You must be equipped with a USB memory stick with a minimum capacity 
of 128 Mo.

Before installing the upgrade, you must format the USB memory stick 
(steps 1 to 5).

1 Insert the memory stick into one of the sockets on the Base Unit 
provided for this purpose.

2 Switch on the Base Unit

3 Press the SYSTEM button

4 Successively select Expert tools >  Media utilities > Usbflash 
Format.

NOTE
The software versions list does not always appear (cf previous ver-
sions) as well as the Show Previous / Next Choice buttons and the 
Confirm/Continue key. In this case, the upgrading starts automati-
cally.

During the upgrade, the Testing indicator is lit in red. Do not 
push any button while the indicator is lit.

USB memory sticks can be very different.
They differ on Hw and Sw aspects, even inside a given brand.

In particular, USB memory sticks targeting audio recording are often 
formatted in very specific ways and the format is often very different 
from a standard FAT.

For all these reasons, we advise users to use memory sticks provided 
by JDSU.

In any case, USB memory sticks which are recognized by the MTS (a 
sound is generated when plugged on the MTS) but which cannot be 
read or written, should be formatted on the MTS with the Usbflash 
Format utility, in Expert tools > Media utilities.

If a problem occurs with the USB stick you are using, contact your 
Local Technical Assistance Center.
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5 Confirm your choice to actually format the USB memory stick.

6 Once formated, disconnect the USB memory stcik from the Base 
Unit using the key Eject USB.
The icon  is displayed, indicating the stick can be removed 
safely.

7 Connect the USB memory stick to the PC

8 Unzip the upgrade files on the PC and transfer it to the USB memory 
stick:

a Download and save on your PC the .exe upgrade file that you 
can get from the web (www.jdsu.com).

b Once the transfer is completed, double click on the .exe file: A 
window called "Winzip self extractor", will appear. Check that the 
folder is correct i.e. the USB memory stick driver is appearing 
"Name:\" then press "Unzip". If not, click on "Browse" in order to 
select the right USB drive.

A message indicating the number of files that have been unzipped 
successfully will then appear.  

c Press "Close".

d Then remove the USB memory stick using the appropriate 
procedure for your PC

As for any media formatting, please note that all data present on the 
USB memory stick will be irremediably lost.

If the .jds file has been chosen, once it is downloaded on the PC, do 
not forget to change its extension to ".exe".

Fig. 5 Winzip Self Extractor
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9 Insert the memory stick, into one of the sockets on the Base Unit 
provided for this purpose.
The icon  is displayed, indicating the stick can be used safely.

10 Press the SYSTEM button, then successively the buttons Expert 
tools > Upgrades > Software Upgrade > Upgrade from USB.
The message Are you sure? is displayed

11 Click on Confirm. 
The list of the software versions available on the USB memory stick 
is displayed next to the versions installed on the Base Unit.

12 Click on Show Previous choice or Show Next Choice to display 
the previous and next versions available.

13 Click on Confirm this Choice to start the upgrade of the selected 
software(s). 
or
Click on Confirm All Choices to upgrade all versions

14 Remove the USB stick as prompted

15 The 4000 shuts down

16 Reinsert the USB as required, in the same USB port as previously 
(repetitive bips advise you to insert the stick).

Upgrading begins. The Base Unit is automatically rebooted. 
Upgrading takes several minutes. During this stage, do not remove 
the USB stick. At the end, the MTS/T-BERD 4000 is automatically 
restarted.

NOTE
A bip is emitted each time the USB memory stick is inserted or 
removed from the Base Unit.

NOTE
The software versions list does not always appear (cf previous ver-
sions) as well as the Show Previous / Next Choice buttons and the 
Confirm/Continue key. In this case, the upgrading starts automati-
cally.

During the upgrade, the Testing indicator is lit in red. Do not 
push any button while the indicator is lit.
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Chapter 3 Graphical User Interface
3

This chapter describes the graphical user interface of the MTS/T-BERD 
4000 used with the optical measurement modules (OTDR etc.).

The topics discussed in this chapter are as follows:

– “Display screen” on page 16
– “Using an external keyboard, mouse and touch screen (options)” on 

page 19
– “Functions relating to display of a trace” on page 21
– “Saving when the instrument is shut down” on page 23
User Manual 770000102/01 15
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Display screen
The display screen is divided into a number of different zones. Starting 
from the top, these are:

– a status bar in which various icons indicate the current functions:
– a bar displaying a scaled-down representation of the trace, showing 

the zoom zone and the parameters of the measurement on display 
(signature of the measurement).

– the main part of the screen, displaying a menu or the page of 
results. 

– tabs enabling the user to switch from one function to another 
(OTDR, VFL, power meter, etc.), as required.

At the right-hand side of the screen, softkeys give access to the various 
commands. Their action depends on the current function and configura-
tion.

Top status bar The top status bar on the screen shows, on the right, current date and 
time, and in the form of icons:

– a different icon according to the type of application and / or the 
name of this function (example:  , ...)

– if data saving is in progress, the icon .
– if the VNC function is used, the icon 

Fig. 6 Example of display of results (with OTDR module)
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– if a battery is set in the Platform, the icon and the battery charge 
level   (see 4000 Base Unit User Manual).

– if a USB stick is connected, the icon 
– if a printing process is in progress, the icon 
– if the Web Browser application is active, the icon 
– if the PDF Viewer is activated, the icon 

Mini-trace The File menu and the Results page can include a scaled-down repre-
sentation of the trace which may show the location of the zoom zone 
corresponding to the main display. The part of the trace shown in the 
main display is boxed on the mini-trace.

This mini-trace will only appear if the trace originated from an MTS/T-
BERD 4000. Other Bellcore files read on this instrument do not contain 
the information needed to display it.

Signature of the
measurement

A status bar repeats the parameters of the measurement, and the posi-
tion of the cursors.

A comment may be displayed.

The name of the file is displayed when the result is recalled from a 
memory.

Main display
zone

The central zone of the screen can display the configuration of the instru-
ment or the measurement, the memory explorer of the MTS/T-BERD 
4000, the measurement results, etc. Refer to the chapter dealing with the 
measurement in progress.

Tabs When the instrument performs several different functions (OTDR,  Power 
Meter, etc.), the various configuration or results pages are accessible 
from tabs. To change from one tab to another, the button selecting the 
page must be pressed. To example:

– on the Results page, to change from one tab to the other, press the 
RESULTS button

– on the measurement configuration page, to change from one tab to 
the other, press the SETUP button

– On the file configuration page, to change from one tab to the other, 
press the FILE button.
User Manual 770000102/01 17
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A small icon may appear in the left corner of each tab, according to the 
status of the corresponding module.

The icon signification is the following :

– No icon : the function is used in a read-only mode (no module), or 
the module has not been selected.

– Gray icon : the function has been selected but the corresponding 
module does not currently perform an acquisition (SM-OTDR in the 
figure).

– Green icon : the function has been selected and the corresponding 
module currently performs an acquisition (LTS in the figure).

Soft keys The 6 softkeys at the side depend on the current configuration and the 
context.

Their use is symbolized by an icon. 

Icons shows that the action is immediate when the key is pressed.

shows that the key gives access to a sub-menu.

shows that the key will quit the sub-menu.

(black direction keys) shows that the function selected by the key 
will be controlled by the direction keys «up» and «down».

Selection keys The selection may be exclusive (only one choice possible) or non-exclu-
sive (more than one option available at the same time):

NOTE
There is a tab for each different type of measurement: OTDR SM, 
LTS... The tab of a function is displayed if and only if a module corre-
sponding to this type of measurement has been inserted in the instru-
ment, or if a file of the type of this measurement is open. If two 
modules of the same measurement type are present, then only one 
module is "active", so only one tab will appear for this measurement. 
To change the active module, go to the HOME screen and select it 
there.
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This key offers two / three exclusive options. The change of 
function occurs immediately, the first time the key is pressed.

This key offers two / three non-exclusive options. Pressing 
the key repeatedly modifies the choice.

Color of the keys When a selection key is associated with direction keys or the confirma-
tion key:

– if the function is not selected, the key is white. 
– pressing the key once selects the function. The key turns blue to 

show the user that the direction keys are assigned to it. Pressing 
more times will modify the choice made using the key.

Using an external keyboard, mouse and touch screen (options)
The external keyboard facilitates input of:

– alphanumerical configuration parameters
– comments in the File menu
– editing characters

The mouse can be used instead of the direction keys to scroll through 
menus and make a selection.

Connect the keyboard and mouse to the USB connectors.

Virtual control
buttons bar

It is possible to emulate hard keys with Virtual Control buttons

To display these buttons, click once on the top of the screen in the status 
bar, at the same height than the date and time.

The virtual control buttons bar is displayed during a few seconds. You 
may click on any of these buttons to obtain exactly the same results than 
using the real buttons in the front panel of the MTS/T-BERD 4000.

Fig. 7 Virtual control buttons bar
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Equivalence
between
external

keyboard and
MTS/T-BERD

4000

Although it is intended primarily to replace the Edit menu of the MTS/T-
BERD 4000, the external keyboard can replace all the buttons and keys 
of the MTS/T-BERD 4000 except the ON/OFF button: 

– The menu keys to the right of the screen are replaced by the func-
tion keys F1 to F6.

– The buttons below the screen are equivalent to Ctrl + a letter (see 
table below).

– The direction keys have the same function on the external keyboard 
and on the MTS/T-BERD 4000.

NOTE
This virtual control buttons bar is especially useful when the MTS/T-
BERD 4000 screen is exported on a remote PC (see the User Manual 
of the 4000 Base Unit).

Function on the 4000 Platform External keyboard 
HOME Ctrl + H

SYSTEM SETTINGS F12
SET-UP Ctrl + U

FILE Ctrl + F
RESULTS Ctrl + R

START/STOP Ctrl + S
SCRIPT (Macro)a

a. The Macro function is called on the 4000 Platform using the AUTO key

Ctrl + M
PRINT Ctrl + Pb

b. The Print function is available directly on the 4000 Platform pushing simul-
taneously the left and right arrow keys.

←  ↑  →  ↓

Menu keys 1 to 6 (from top to bottom) F1 → F6
ABOUT F11

Save and quit (Exit) Entrée/Enter
Quit without saving (Abort) Escape/Echap.
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Editing text
using the

external
keyboard

To use the external keyboard to insert a name or identification in the set-
up menus:

– Press Enter to go into the Edit menu
– Type the text
– Press Enter to leave the Edit menu.

Pressing the Esc key will close the Edit menu without saving the 
text.

Functions relating to display of a trace
The trace acquired or recalled from a memory is displayed on the Results 
page: see example on Figure 6 on page 16.

Various functions common to many modules (OTDR etc.) can be used to 
modify the display of the trace (Cursors, Zoom/Shift, Event/Trace, Trace/
Table, Full scale, etc.). The role of the direction keys and the confirmation 
key will depend on the function chosen.

Display of the
results on the

trace

Each event (OTDR measurement) detected is represented under the 
trace by a serial number.

The results of the measurements can be written on the trace.

Depending on the options chosen in the SETUP menu on Result Screen 
> Results On Trace, it is possible to show on the trace, for an OTDR 
measurement:

– "No" results, 
– or "All" the results (value and position) 
– or only the markers showing the position of the events measured

When there is saturation for a reflective event (OTDR measurement), the 
maximum value measured is displayed with the sign >. This shows that 
the actual reflectance is greater than the value shown (for example, if 
R >-29.5 dB is displayed, the reflectance could be -18 dB)

The reflectance of a ghost event (OTDR measurement) is displayed in 
brackets on the trace.

Cursors The vertical cursors A and B are used in the Zoom and Shift functions to 
position or delete events. 
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The cursors A and B are represented by vertical lines of different colors:

– in a solid line if the cursor is selected.
– in a dotted line if the cursor is not selected.

Press the key  to active the cursor(s)

Positioning the
cursor

When a trace is displayed, the key Cursor A/Cursor B can be used to 
select one or both cursors.

The direction keys  and  move the selected cursor(s) along the trace.

Above the trace are shown the co-ordinates of the points of intersection 
of the cursors A and B with the trace, together with the distance between 
the two points.

When a selected cursor touches the right or left-hand edge of the screen, 
the trace starts to scroll horizontally to maintain display of this cursor.

If an unselected cursor has been moved off-screen by a zoom, it can be 
brought back on to the screen by selecting it and then pressing one of 
the direction keys  or . It will then appear on whichever edge of the 
screen is closest to its position.

When the cursor function is selected, the keys  and  move the trace 
vertically.

Zoom and Shift
functions

Zoom function The Zoom function is used to analyze part of the trace in greater detail. 
In association with Event (OTDR) it enables rapid checking of a succes-
sion of events.

The zoom is centred on the cursor selected. If the two cursors A and B 
are selected, the zoom is centred midway between the two cursors.

The position of the section of trace displayed with respect to the complete 
trace is represented by a red rectangle on the mini-trace at the top left-
hand corner of the screen. 

To define a zoom on the trace:

– select cursor A or B and center it on the zone to be examined
– on the Shift/Zoom key, select the Zoom function.
– use the or  key to increase or reduce the zoom factor.
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Zooming on the different events in succession (OTDR)
– Zoom on one of the events detected as shown above.
– On the Trace/Event key, select the Event function
– Use the  and  keys to move the zoom on to the successive 

events.

Shift function The Shift function is used to displace the displayed section of the trace 
by pressing the direction keys. 

The horizontal shift is performed maintaining the point of intersection 
between the trace and the selected cursor at the same level, scrolling the 
trace horizontally while following it vertically, so that it never goes off the 
screen.

To use this function:

– Select the zoom factor as described above.
– Choose cursor and cursor position.
– On the Zoom/Shift key, select Shift.
– Use the direction keys to shift the trace in the desired direction.

Zoom Auto (OTDR) The Zoom Auto function allows to go to an optimized display of the 
trace. To apply the Zoom Auto on the trace, maintain the ENTER button 
pushed for a few seconds.

Display of the
entire trace

To display the entire trace on the screen, push simultaneously the  
+ HOME keys.

Saving when the instrument is shut down
When the instrument is switched off, all the parameters and all the traces 
are saved, and will all be recalled at the next start-up.
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Chapter 4 Reflectometry Measurements
4

Pressing the START/STOP key is all that is needed to start or stop a 
measurement. However, it is necessary to configure the measurement 
and the type of results desired.

This chapter describes the different stages in a reflectometry measure-
ment made using an OTDR module.

The topics discussed in this chapter are as follows:

– "Selecting the function" page 26
– "Configuring the reflectometry test" page 26
– "Traffic Detection function and connection quality indicator" page 32
– "Acquisition in Real Time mode" page 34
– "Acquisition in Fault Locator mode" page 36
– "Acquisition in Quick Link Test mode" page 37
– "Acquisition in Construction mode" page 39
– "Result page in Fault Locator mode" page 41
– "Result page in Construction and Quick Link Test mode" page 42
– "Advanced functions in Construction mode" page 47
– "File Management" page 57
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Selecting the function
Press the HOME button. If the instrument is equipped with several 
modules or if the sole module performs several functions:

– use the direction keys  and  to select the function: the icon 
under the mouse pointer is surrounded with a white frame.

– select the function by pressing ENTER: the icon turns yellow.

– The icon TD allows to activate the trafic detection function (see 
“Traffic detection” on page 32).

– The icon Source allows to activate the light source (option) on the 
OTDR Module.

– The icon Powermeter allows to activate the Power meter function 
(option) on the OTDR Module.

Configuring the reflectometry test1
To call up the test configuration window, press the SETUP button.

Dialog boxes on the same screen enable selection of acquisition and 
measurement parameters, of display of results and of ifber parameters.

Fig. 8 Example of HOME Page with OTDR Module

1.if an OTDR module is installed
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In these windows, the parameter selected is in video inverse. Select this 
parameter by means of the direction keys  and .

The available choices then appear on the screen; they depend on the 
function selected. Make the choice by means of the direction keys   .

Acquisition
parameters

You can choose the following acquisition parameters, whatever the type 
of measurement displayed on the trace. 

If the acquisition parameters are not accessible, check that the OTDR 
function has really been selected (see "Selecting the function" page 26).

– Mode Choose the mode of detection of events:
Construction: the acquisition parameters are accessible by the 

user. This mode can be configured either auto-
matically or manually by the user (select Auto or 
Manual on the key .

When acquisition is complete, a measurement is
made and the results are displayed.

Quick Link Test: the MTS/T-BERD 4000 starts an acquisition with 
an automatic configuration making the best 
compromise for Pulse/Range/Resolution. When 
acquisition is complete, a measurement is made 
and the results are displayed.

Fig. 9 OTDR LM SETUP screen (construction mode)

Those measurement parameters are only linked to the next acquisi-
tion.
User Manual 770000102/01 27



Chapter 4 Reflectometry Measurements
Configuring the reflectometry test

MTS4000 Module US rev01.book  Page 28  Jeudi, 26. février 2009  2:03 14
With this 2 modes, the results table is displayed, which allows to charac-
terize the events.

However, in Quick Link test mode, the advanced functions and the «Set 
Event» function in the results page are not available, whereas they can 
be used in Construction mode see “Advanced functions in Construction 
mode” on page 47).

Fault Locator the Fault locator mode allows to detect the end of 
fiber distance from the origin and, by consequence, 
to detect a possible break of this fibre. It also allows 
to display the total loss.

– Laser The acquisition will be carried out on the wavelength(s) 
selected (for multiple-wavelength modules). In case of 
a multi-wavelength module, select All to perform a 
measurement for all the wavelengths available (this 
parameter visible exclusively on modules with one 
single OTDR port). The possible values depend on the 
module used. 

– Pulse From 3ns to 10µs. Parameter selectable by user in 
Construction mode > Manual. It is automatically 
configured by the equipemnt in the other modes.
See "Typical specifications of OTDR modules" page 97.

– Range The possible range depends on the pulse length 
selected. This range is given for each pulse length in 
the paragraph "Ranges" page 98. This parameter is 
exclusively configurable in Construction mode> 
Manual.

The Auto parameter allows to detect automatically the range.
In Auto mode, the range is selected as a function of the end of the 
fiber.

– Resolution
This parameter is exclusively configurable in Construction mode> 
Manual.
In Auto mode, resolution is selected automatically according to the 
last two parameters above.
High Resolution: the highest resolution is applied
High Dynamic: the highest dynamic is applied

– Acquisition time
- Real time: the equipment performs up to ten acquisitions per 

second. This mode makes it possible to analyze a 
fiber quickly without any memory effect, and thus to 
check the establishment and quality of the connec-
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tions.

- Manual: Enter the acquisition time wished (from 5 s. to 5 
minutes max).

- Predefined Select one of the acquisition times predefined: 10 
seconds / 20 seconds / 30 seconds / 1 minute / 2 
minutes / 3 minutes.

Test Auto
The Test Auto key imposes the following parameters:

– Acquisition parameters:

Pushing the Test Auto key configure the equipment for one measure-
ment on all the lasers, and an automatic acquisition time.

– Saving parameters (see "File management" page 69):
File naming: 
Fiber[Cable] [Cable_Id][Fiber_Num] _[Lambda][direction]
Increment Fiber number: Yes
Auto Store: yes

Factory default settings
The Factory Defaults key imposes the parameters for acquisition, 
measurement and display of results defined as default settings in factory.

Measurement
parameters

You can select the following measurement parameters, in the Measure-
ments field.

Detection
Choice of events to be detected:

– Ghosts (construction mode only):
Choice (Yes / No / No Analysis) of whether information relating to 

NOTE
Whatever is the acquisition mode selected, an acquisition in real time 
mode can be launched maintaining the START/STOP button pushed 
for about 2 seconds.

Those parameters are valid for all traces present on the screen.
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ghosts is to be displayed. If ghosts are displayed, the reflection icon 
in the table of results appears dotted and the reflection value is 
displayed in brackets on the trace, for example «(R:-50 dB)».

– Fiber end
– Auto (recommended) option in which the MTS/T-BERD 4000 

automatically detects the end of a fiber.
– 2 to 20 dB (steps of 1 dB): threshold of detection of end of fiber. 
Test Auto mode: Auto.

With any dual or triple-wavelength measurement module, the user will 
have access to the macro bend detection function in the test setup. Each 
event of the selected wavelengths will then be compared.
– Bend: 

Select the bend value (in dB), with direction keys or numeric keypad.
Test Auto mode: Auto

Index of refraction
Choice of group refraction index of the whole fiber. 

– User
– Either: define for each wavelength (1310 SM, 1360-1510 SM, 

1550 SM, 1625 SM) a refraction index of 1.30000 to 1.69999. 
The selection of an index alters the value of the section AB 
(actual distance between cursors A and B).

– or, if the actual distance between the cursors A and B is known, 
enter its value under Section AB to establish the index of the 
fiber. Selection of this distance causes the display of the indices. 
The extreme distance values are given by the index values 
(1.30000 à 1.70000).

– Predefined index 
– It is possible to choose one of the predefined values given for 

certain cables. The corresponding indices given in the table 
below are repeated on the screen.

NOTE
Ghosts are detected only during an automatic measurement.

Wavelength (nm) 1310 SM 1475 1480 
1510 1550 1625 SM

ATT SM 1.46600 1.46700
Corning SMF-28 1.46750 1.46810
Corning SMF-DS 1.47180 1.47110
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Fig. 10 Predefined index values (Single Mode)

Scatter coefficient 
– User Selects for each wavelength, the backscatter coefficient of 

-99 dB to -50 dB by increments of 0.1dB. Modification of 
the backscatter coefficient K changes the measurements 
of reflectance and ORL. 

– Auto Backscatter coefficients are selected automatically for 
each wavelength.

The default values are given in the paragraph "Reflectance" page 3.

Launch cable at start / Launch cable at end
– No All the results are displayed and referenced on the 

basis of the board of the module.
– Evt 1, 2, 3 The results relating to the launch cable are eliminated 

from the table. Attenuation and distances are then 
measured on the basis of the marker Evt 1, 2 or 3 
selected.

– Distance Use the Edit Number key to enter a distance (Min= 0 / 
Max=10 km / 32.81 kfeet / 6.22 miles) or affect the 
active cursor value, using the Set Cursor Distance 
key.

Results screen

– Alarms > Threshold (not available in Fault Locator mode)

Corning SMF-LS 1.47100 1.47000
Corning-LEAF 1.46890 1.46840
Fitel Furukawa 1.47000 1.47000
Lucent Truewave 1.47380 1.47320
Litespec 1.46600 1.46700

Wavelength (nm) 1310 SM 1475 1480 
1510 1550 1625 SM

NOTE
The parameter Launch Cable at end is only available in construction 
mode.

Those parameters are valid for all the traces present on the screen.
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None: The alarm function is not active.
Fail: This menu lists possible major alarm thresholds that the 

user could select. If results are above those thresholds, 
they will be highlighted in red in the table of results, and 
the icon  will appear at the top right of the screen.

Warning: This menu lists possible minor alarm thresholds that the 
user could select. If results are between those thresh-
olds and the "fail" thresholds, they will be highlighted in 
yellow in the table of results, and the icon  will 
appear at the top right of the screen 

If all the results lie within the thresholds (no result is in red or yellow), the 
icon will be .

– Results on trace (Construction mode only):
None: the trace alone.
All: the trace with results and markers.
Graphics only: the trace with markers only. 

If «All» or «Graphics only» is selected, the reflectometry trace is 
displayed with a dotted vertical line set on the end of launch cable   
(if the Launch Cable is defined in the SETUP menu) and a dotted vertical 
line on the end of fiber .

– Unit Units of the distances displayed: km, kfeet, miles, 
metre, feet.

Traffic Detection function and connection quality indicator

Traffic
detection

Traffic on the fiber under test can be detected and reported if the function 
TD (Traffic Detection) has been selected on the Home page.

If the fiber connected to the OTDR module is active, a message indi-
cating a signal in the fiber under test is displayed.

Push any key to continue.

NOTE
According to the value set for Alarm > Bend max, the trace display will 
get a Bend selection with the Trace/Table/Summmary softkey, allow-
ing to display the splice differences in the table result.
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Press the START/STOP key to begin the measurement. A message indi-
cates there is traffic on the fiber and asks you if you wish to continue or 
not:

– If you click on NO, the measurement is not launched.
– If you click on YES, the measurement is performed, despite the 

traffic.

If the Traffic Detection function is not selected on the Home page, then 
the message Signal Detected on fiber under test is 
displayed, but the acquisition is although performed once any key is 
pressed (no warning message asking you if the measurement must be 
performed or not is displayed).

Connection
quality

indicator

An indicator of the state of the connection (Good / Bad) is given at the 
beginning of an acquisition, whatever is the acquisition mode selected.

The connection quality indicator gives the following information:

If the state of the connection is bad, it is still possible to carry out a 
measurement, but the results will not be very reliable.

NOTE
If the measurement is validated despite the traffic (key YES), the next 
measurement will be automatically performed, even if traffic is still 
detected on fiber.

If the measurement is cancelled (key NO), and the START/STOP 
pushed another time, the box asking if you wish to continue or not is 
displayed.

State Connection
Good The connection is OK
Bad Possible causes of a bad result: 

- There are several connectors close to the external connector of the MTS/T-
BERD 4000.
- One of the connectors is dirty or badly connected. Replace the launch cable, 
make the connection again properly or clean the connector of the OTDR or of 
the jumper.
- No fiber is connected.

NOTE
If the connection is bad, check and clean the connector / jumpers (see 
“Cleaning the universal connector” on page 7).
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Acquisition in Real Time mode

Principle of the
Real time mode

Acquisition in real time must not be used if a precise measurement is 
required because of the high noise level, but it is sufficient for rapid opti-
mization of a connection and for observing a fiber in process of utilization.

Performing an
acquisition in

Real Time mode

To carry out an acquisition in real time, after selection of the requisite 
acquisition parameters (see "Acquisition parameters" page 27):

– Hold the START/STOP key down for about two seconds, to launch 
the acquisition in real time, whatever is the Acquisition mode 
selected in the Setup page. 

– or, in the Setup page, select the Construction mode in the Acquisi-
tion menu and choose Real time mode in the Acq. Time line. Then 
press the START/STOP key. 

The red Testing indicator will go on to show that real time acquisition is 
in progress. The trace acquired is displayed in real time. An indicator of 
the state of the connection (Good/Bad) is displayed below the trace. 

Real time display

During an acquisition in real time, you can modify the acquisition param-
eters without returning to the SETUP menu. To do this, press the Acqui-
sition Param key: you can then use display keys to scroll through the 
possible values of the various acquisition parameters.
In real time mode, only measurements relating to the cursors are 
possible, but as soon as acquisition stops, automatic measurement is 
possible.

Fig. 11 Example of acquisition in real time
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The real time mode allows to make Loss, ORL or Reflectance measure-
ment using the A & B cursors and the key None / Loss / ORL / Reflect.:

1 Position A & B cursors on the trace

2 Click as many times as necessary to get the Loss / ORL / Reflec-
tance measurement between A & B cursors
The result is displayed under the trace.

To stop or interrupt an acquisition in real time mode, press the START/
STOP key.

Multi-wavelength
acquisition

If the module possesses several lasers, to perform successive acquisi-
tions on all the wavelengths:

– in the SETUP menu, check in Laser line, that several lasers are 
selected (or select All if a module with only one OTDR port is used) .

– start the acquisition by pressing the START/STOP button.
– Once the acquisition for the first wavelength is finished or to stop it 

manually, click on Stop Wavelength to stop the measurement for 
this wavelength and automatically start the measurement for the 
following one.

The different traces appear in the same window.

Fig. 12 Example of loss measurement between A & B cursors
User Manual 770000102/01 35



Chapter 4 Reflectometry Measurements
Acquisition in Fault Locator mode

MTS4000 Module US rev01.book  Page 36  Jeudi, 26. février 2009  2:03 14
Acquisition in Fault Locator mode

Principle of the
Fault Locator

mode

The Fault locator mode is used to detect  the distance of  the end of fiber  
from its origin. Consequently, il allows to detect a possible break of the 
fiber. It also allows to calculate the Total Loss.

Performing an
acquisition in
Fault Locator

mode

1 Push the SETUP button

2 In the Acquisition parameters:
– Select  Fault Locator in the line Mode (see "Configuring the 

reflectometry test" page 26)

3 Configure the other acquistion parameters (see .“Acquisition param-
eters” on page 27)
or click on Test auto to configure automatically the acquisition 

4 Push the START/STOP button.
The test configuration starts automatically. 
A baragraph indicates the  quality of the connection (see "Real time 
display" page 34)

Then, the elapsed averaging time and the number of averages calcu-
lated are displayed.

The acquisition can be stopped at any time pushing START/STOP button.

Fig. 13 Acquisition in progress in Fault Locator mode

Total acquisition timeElapsed timeElapsed 
acquisition time

Number of averages 
calculated
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Multi-wavelength
acquisition

If the module possesses several lasers, to perform successive acquisi-
tions on all the wavelengths:

– in the SETUP menu, check in Laser line, that several lasers are 
selected (or select All if a module with only one OTDR port is used) .

– start the acquisition by pressing the START/STOP button.
– Once the acquisition for the first wavelength is finished or to stop it 

manually, click on Stop Wavelength to stop the measurement for 
this wavelength and automatically start the measurement for the 
following one.

The different traces appear in the same window.

Acquisition in Quick Link Test mode

Quick Link Test
acquisition

mode

The fastest way of detecting faults in your optical fiber is to use automatic 
acquisition mode. The MTS/T-BERD 4000 then uses the acquisition 
parameters (pulse width, range and resolution, and acquisition time) best 
suited to the fiber to be tested.

Performing an
acquisition in

Quick Link Test
mode

Press the SETUP button, then:

1 On the Mode line, select Quick Link Test,
2 On the Laser line, select the wavelength of the laser or select 

several lasers to perform a multi-wavelength acquisition (the param-
eter All is available if a module with only one OTDR port is used)

3 Select the Measurements and Result screen parameters wished

You can also configure the Quick Link Test automatically by pushing the 
Test Auto key, or according to the parameters set in factory by clicking 
on the Factory Defaults key.

Acquisition phases and  Quick Link Test dislpay
When the START/STOP key is pressed, the acquisition is carried out in 
four phases:

– Phase 1: Choice of the best range to display the whole of the fiber 
under test.

– Phase 2: Choice of the ideal pulse width and of the acquisition time 
to qualify the fiber accurately; for example the one that gives the 
best resolution for a given dynamic.
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– Phase 3: Display of the quality of the connection (see "Connection 
quality indicator" page 33)

– Phase 4: The elapsed averaging time and the number of averages 
calculated are displayed. When the duration of acquisition has 
elapsed, the automatic measurement is carried out.

At the end of an acquisition, a beep is emitted.

Multi-wavelength
acquisition

If the module possesses several lasers, to perform successive acquisi-
tions on all the wavelengths:

– in the SETUP menu, check in Laser line, that several lasers are 
selected (or select All if a module with only one OTDR port is used) .

– start the acquisition by pressing the START/STOP button.
– Once the acquisition for the first wavelength is finished or to stop it 

manually, click on Stop Wavelength to stop the measurement for 
this wavelength and automatically start the measurement for the 
following one.

The different traces appear in the same window.

NOTE
The acquisition can be stopped at any moment by pressing the 
START/STOP key. Then an automatic measurement is performed.

Fig. 14 Example of automatic acquisition

Number of 
averages calculated

Elapsed 
acquisition time

Total acquisition timeElapsed time
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Acquisition in Construction mode

Principle of the
Construction

mode

In this mode, the MTS/T-BERD 4000 carries out a number of averagings 
defined as a function of the maximum acquisition time specified in the 
Acquisition menu, and then terminates the acquisition. The acquisition is 
carried out with the parameters previously selected in the Acquisition 
menu. It may be stopped at any time using the START/STOP key.

Configuring the
acquisition

To configure an acquisition of the fiber under test, follow the procedure 
described below, in the SETUP menu (see "Acquisition parameters" page 
27):

1 On the Mode line, select Construction.

2 Select Manual or Auto using the key Acquisition Manual / Auto
3 If Manual has been previously selected, select the wavelength on 

the Laser line (the parameter All is available if a module with only 
one OTDR port is used).

4 If Manual has been selected, on the Pulse line, select the required 
pulse length from the values proposed.

5 If Manual has been selected, select the required Range from the 
values proposed.

6 If Manual has been selected, select the Resolution.

7 On the Acquisition Time line, select the duration of acquisition.

Performing an
acquisition in
Construction

mode

1 Press the START/STOP key to start the acquisition.

The red indicator goes on to show that the MTS/T-BERD 4000 is in 
process of acquisition and the screen displays the trace in process of 
acquisition.

The quality of the connection is displayed for a few seconds (see 
“Connection quality indicator” on page 33), then a bar graph shows 
elapsed and remaining acquisition time. 
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At the end of the acquisition, the trace is displayed and an automatic 
measurement is started.

Multi-wavelength
acquisition

If the module possesses several lasers, to perform successive acquisi-
tions on all the wavelengths:

– in the SETUP menu, check in Laser line, that several lasers are 
selected (or select All if a module with only one OTDR port is used) .

– start the acquisition by pressing the START/STOP button.
– Once the acquisition for the first wavelength is finished or to stop it 

manually, click on Stop Wavelength to stop the measurement for 
this wavelength and automatically start the measurement for the 
following one..

The different traces appear in the same window and can be handled simi-
larly to overlaid traces (see "Swapping overlay traces" page 55).

Fig. 15 Acquisition in progress in Construction mode

Number of 
averages calculated

Elapsed 
acquisition time

Total acquisition timeElapsed time

NOTE
To stop the acquisition, the START/STOP key may be pressed at any 
time. Then an automatic measurement is carried out, but some events 
cannot be detected (a manual measurement must then be made).
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Result page in Fault Locator mode
The trace acquired or recalled from a memory is displayed on the Results 
page.

Once the acquisition is performed in fault locator mode, under the trace 
are displayed the end of fiber distance, with the unit chosen, and the Total 
Loss value.

A dotted vertical line is displayed on the end of fiber 

A number of different functions can modify the display of the trace

– Cursor A / Cursor B (see "Cursors" page 21)
– Zoom/Shift (see "Zoom and Shift functions" page 22)
– Table/Summary (see "Table/Summary function" page 42)

Under the trace, in the blue line, are displayed:

– the ORL value of the link
– the Launch Cable length (if defined)

Fig. 16 Fault Locator result

NOTE
If a problem occurs during acquisition, two types of message can be 
displayed on screen:

- Fiber End not found: fiber length is too long for the OTDR used etc.

- No fiber connected
User Manual 770000102/01 41



Chapter 4 Reflectometry Measurements
Result page in Construction and Quick Link Test mode

MTS4000 Module US rev01.book  Page 42  Jeudi, 26. février 2009  2:03 14
If one or several bends have been detected, the screen displays the 3 
first macro bends detected, as well as, for each one, the distance and the 
delta loss between the two wavelengths (dB).

Table/Summary
function

To display a summary of the results, for 2 traces or more in overlay, select 
the Summary function in Fault Locator mode, using the key .

An additional window is displayed, with issue highlighted in case of 
problem, including bend.

Result page in Construction and Quick Link Test mode

Trace display
function

The trace acquired or recalled from a memory is displayed on the Results 
page.

A number of different functions can modify the display of the trace

– Cursors (see "Cursors" page 21)
– Zoom/Shift (see "Zoom and Shift functions" page 22)
– Trace/Event (see “Trace/Event functions” on page 44)

In Summary mode, there is neither access to other functions because 
the Summary function analyzes two traces at the same time. Go back 
to the Table function to have access to these functions.

Fig. 17 Fault Locator: Summary page
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– Trace/Table/Summary (see “Table of results” on page 45 and 
“Summary page” on page 46)

Display of
events on the

trace

Each event detected is referenced under the trace by a serial number.

The reflectometry trace is displayed with a dotted vertical line set on the 
start of launch cable  (if the Launch Cable Start is defined in the 
SETUP menu)

In construction mode, the trace can also be displayed with a dotted 
vertical line on the end of fiber , if the Launch Cable end has been 
defined in the Setup menu.

The results of the measurements of attenuation, reflectance and slope 
can be marked on the trace.

The reflectance of a ghost event is displayed in brackets on the trace 
(construction mode only).

NOTE
At the end of an acquisition, a beep is emitted.

NOTE
In construction mode, to display the results on the trace, make sure 
that the option selected in Results on Trace is All in the menu 
SETUP.

Fig. 18 Exemple of trace (in Construction mode)

In Quick Link 
Test mode, this 
2 keys are not 
available
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Trace/Event
functions

1 The Trace function is useful in a multi-trace display, as the direction 
keys can then be used to select the active trace, which turns green.

2 The Event function of the MTS/T-BERD 4000 enables the cursor to 
be moved on to the faults that have been measured and the results 
of which are displayed on the screen.

After selecting the Event function on the Trace/Event key, pressing the 
keys , ,  or  once will move the cursor from one event to the 
next. This function, in association with Zoom and Cursor, enables rapid 
analysis of the fiber.

Criteria for display
of an event

An event will be displayed if its attenuation or its reflectance exceeds the 
corresponding threshold selected in the SETUP menu (see "Acquisition 
parameters" page 27). Attenuation and reflectance results for an event 
will be displayed if they can be calculated

The reflectance of an event is always measured except when the event 
causes a saturated Fresnel peak or if it is drowned out by noise. In this 
case, the MTS/T-BERD 4000 displays > to show that the actual reflec-
tance exceeds the value displayed. 

When there is saturation for a reflective event, the maximum value 
measured is displayed with the sign >. This shows that the actual reflec-
tance is greater than the value shown (for example, if R >-29,5 dB is 
displayed, the reflectance could be -18 dB)

Relative measurement
Relative measurement, using the 2 point method, can be carried out by 
means of the Event function in coordination with the two cursors. For 
example, you can analyze the total loss on a link with launch cable:

1 Place one of the cursors at the end of the launch cable.

2 Select the other cursor.

3 Use the Set Event function. The measurements displayed give the 
actual distance from the start of the link and the attenuation of the 
link plus the attenuation of the connection.

NOTE
While moving from one event to another, the value of the zoom is con-
served (unless this is impossible).
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Table of results

A table of results is displayed under the trace, with the Quick Link Test or 
Construction mode.

Two types of tables of results are possible with the MTS/T-BERD 4000:

– A table with a line displayed under the trace and giving the type and 
characteristics of the event nearest to the cursor.

– A table giving the type and the characteristics of all the events 
detected during the measurement: the 4 first lines displayed corre-
spond to the 4 first events nearest to the cursor. The line corre-
sponding to the event nearest to the cursor is highlighted. This 
highlighting moves if the cursor is moved.

At the top of the table, a line shows the generic parameters of the fiber: 
numbers of events present, total ORL of the link, marker locking icon and 
launch cable length (if selected).

To obtain the 4-line table, select the Table function on the Trace/Table/
Summary key. To return to display of a single line in the table, select the 
Trace function.

To scroll through the table, if it contains more than 4 lines:

– either select the Cursors function, and move the selected cursor 
along the trace using the keys  and 

– or select the Event function, and move the cursor through the table, 
using the keys  and .

NOTE
In construction mode, to display all the events, make sure that the 
detection threshold selection in the SETUP menu is All.

Fig. 19 Exemple of table of result (in Quick Link Test mode)
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Information provided for each event detected
Each event is referenced under the trace by a serial number which is 
repeated in the first column of the table. The table then shows:

– an icon symbolizing the type of the event:

Non-reflecting attenuation (e.g. splice).

Event with reflection (e.g. connector).

 Ghost reflection.

 Slope of the fiber (when no fault follows the slope).

End of fiber

ORL measurement

Event marker when a measurement cannot be carried out. If
the event to be added is too close to an existing event, the icon
appears on the trace and the table, but no measurement is
carried out: to obtain the results for this event, a manual
measurement is necessary.
End of launch cable: the attenuation and distances are
measured on the basis of the corresponding marker.

– The distance of the event from the beginning of the fiber, in metres 
(or kfeet or miles).

– The attenuation due to the event, in dB.
– The reflectance of the event, in dB (or the ORL result if an ORL 

measurement has been carried out).
– The slope before the event, in dB/km (dB/kft) if it can be measured.
– The length of the section, that is to say the distance between the 

marker of the event and the previous marker.
– The total attenuation of the fiber (total dB loss), in dB.

The table of results is interactive, and reflects the measurements in prog-
ress. Any operation carried out on the trace is immediately entered in the 
table, so that you can see the result. 

Summary page To display a summary of the results, for 2 traces or more in overlay, select 
the Summary function using the key .
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An additional window is displayed, with issue highlighted in case of 
problem, including bend.

Advanced functions in Construction mode

Automatic
measurement
and detection

Automatic mode enables rapid detection of all the faults in the trace. The 
faults detected are then measured and identified on the screen by 
markers. Only the results exceeding the detection threshold defined in 
the SETUP menu are displayed.

By means of this method of detection, you can quickly locate all the faults 
in the fiber under test.

If an automatic measurement does not detect all the events, additional 
manual measurements can be carried out.

Fig. 20 Summary Results and Bend Table

In Summary mode, there is neither access to other functions because 
the Summary function analyzes two traces at the same time. Go back 
to the Table or Trace function to have access to these functions.

NOTE
Before starting an automatic measurement, make sure that the func-
tion Lock Evts (accessible by pressing Advanced), is not activated 
(the icon  must not be present in the left-hand corner under the 
trace).
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To delete all the markers, press the Advanced key, then select Del Res..

When there have not been any measurements, to carry out an automatic 
measurement, press Advanced then select the function Auto Mes..

The following procedure is recommended:

1 Fully automatic measurement: the instrument locates the events 
and proceeds to the measurements.

2 Addition of events (see “Addition of events” on page 48) in the cases 
of splices showing low attenuation and of close events. The MTS/T-
BERD 4000 then automatically measures the slope before and after 
the markers selected and measures the attenuation of the splice.

3 Addition of manual measurements if necessary (in the case of very 
close events). The MTS/T-BERD 4000 performs the measurements 
requested by the user.

To start an automatic measurement while a measurement is already in 
progress:

1 Press the Advanced key.

2 Select Del Res..
3 Select Auto Mes..

Addition of
events

To carry out a measurement, it is advisable to go into the SETUP menu 
and:

– activate the alarm thresholds in Result Screens > Alarms 
– validate display of results on the trace in Results on Trace = All.

You can place markers of events on the trace at the exact position where 
you want to carry out automatic measurements. 

You can also manually place markers in addition to those positioned 
automatically during automatic measurement. You can then start an 
automatic measurement to obtain the results on all the markers.

Representation of
the events

The events are represented by the symbol : if they are set during auto-
matic measurements or using the Set events key.

The events are represented by the symbol  if they are set during 
manual measurements in Advanced mode.

To add markers of events:

1 Select a cursor (A or B).
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2 Use the direction keys to move the cursor to the place where you 
want to position a marker.

3 Press the key: Set Event.
4 An event marker  is displayed at the position of the cursor and a 

measurement is carried out on the event. Measurement of slope 
before the marker starts just after the previous event (or at the end 
of the dead zone at the beginning of the fiber); measurement of 
slope after the marker stops just before the next marker or at the 
end of the fiber.

Hints on the
positioning of

markers

– Do not add markers (with the Set Evt key) after a manual measure-
ment, as all the results will be recalculated automatically by the 
instrument.

– If two markers are too close together, they will appear on the trace 
and the table but no measurement will be carried out on the second 
marker: to obtain results for this marker, a manual measurement is 
necessary.

– If you press the Set Evt key when the cursor is very close to a 
marker, the latter will be deleted.

Deleting events To delete an event, move the cursor onto the event and press the Set 
Event key. The event selected will be deleted and a complete measure-
ment, without this event, will be carried out.

Deletion of events can cause incorrect measurement results.

Manual
measurements

As soon as you have made an acquisition, with or without automatic 
measurement, you can make manual measurements on any event on 
the trace by means of the cursors A and B, in association with the func-
tions of slope, detection of splice and calculation of ORL.

The manual measurements are accessible in the Results page, after 
pressing the keys: Advanced, then Manual Measurement.

Measurements of
slope

To make a manual measurement of slope, press the RESULTS button to 
call up the trace and then:

– Place the cursor A at the beginning of the section of the trace where 
the slope is to be measured.

– Place the cursor B at the end of this section.
– Press the Advanced key, then the Manual key, then select Slope. 
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– Press ENTER: the slope of the specified trace section is displayed.

Result of slope measurement
The result is displayed on the screen between the two slope indicators 
[ and ]. 

The measurement results are also available in the table which you can 
display in its entirety by selecting the Table function (after pressing Exit 
to quit Advanced mode). In the table:

– "distance" shows the distance between the beginning of the trace 
and the end of the slope; 

– "length" shows the distance between the previous event (which may 
also be the beginning of the link) and the end of the slope. Thus this 
section value is not equivalent to the distance between the two 
slope indicators [ and ].

– "Slope" shows the slope value in dB/km

If no result is displayed in the table:

– the distance between the cursors A and B is too small.

Deleting a slope measurement 
To delete a particular slope measurement result:

– superimpose the cursors A and B on the slope concerned
– select Slope (after, if necessary, pressing Advanced > Manual).
– press ENTER: the slope of the specified trace section is deleted.

Fig. 21 Manual Measurement results

Slope Reflectance
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Performing splice
and reflectance
measurements

There are two methods of carrying out manual measurements of splices 
on the trace: the two-cursor method and the five-cursor method.

The five-cursor method is the more accurate, as it takes into account the 
difference of level between the slope before the splice and the slope after 
the splice. This method should be used whenever possible.

If very close events have created a dead zone preventing the measure-
ment of slope by the five-cursor method, it is possible to use the two-
cursor method. This considers the difference in level between the 
cursors.

Before performing one of these measurements, define in the Setup 
menu the splice detection threshold (All is recommended) and confirm 
display of the results on the trace (Results on Trace= All or Graphics 
only).

Two points method
To perform a splice measurement by the "two-points" method, display the 
Results page, then:

1 Place cursor A exactly on the fault, then place cursor B after the 
splice that you wish to define.

2 Press the Advanced key, then Manual Measurement, then select 
the function 2 Pt Loss.

3 Press ENTER.
The splice marker is placed at the point defined by the first (left-
hand) cursor and the result is displayed on the screen. If the fault is 
reflective, the reflectance value is also measured and displayed. 
These results are added to the table of results.

If no result is displayed, it is possible that No or Graphics only has been 
selected on the Results on Trace line in the Setup menu.

Five points method
To carry out a splice measurement by the "five points" method:

1 Measure the slope preceding the fault to be measured, then the 
slope following it.

2 Place the cursor on the fault (between the two sections).

NOTE
If you try to measure a splice on a slope, the measurement is not car-
ried out and the following error message is displayed: "Slope found 
between two cursors".
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3 Press the Advanced key, then Manual Measurement, then select 5 
Pt Loss.

4 Press ENTER.
The splice event marker is placed on the cursor and the result is 
displayed on the trace and in the table of results.

Manual
measurement of

ORL

It is possible to carry out an ORL measurement on a part of the fiber.

Follow the following procedure to measure a part of the fiber:

1 Position the cursors A and B to delimit the section that you wish to 
measure.

2 Press the Advanced key, then Manual Measurement, then select 
ORL.

3 Press ENTER. The ORL is measured for the section of trace defined. 

NOTE
If no result is displayed, it is possible that the display threshold of the 
attenuation measurement result is higher than the attenuation that 
you are trying to measure, or else, in the SETUP menu, you may have 
selected Results on Trace = None or Graphics only.

NOTE
If you try to measure a splice on a slope, the measurement is not car-
ried out and the following error message is displayed: Slope found 
between two cursors.

Fig. 22 Result of ORL measurement
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ORL on a saturated trace
If saturation occurs during an ORL measurement, the result is given with 
the sign <. This means that the actual ORL value is less than the value 
displayed.

Memorization of
the position of

events

To memorize the position of events with a view to repeating the measure-
ments at the same place during a future acquisition or on another trace, 
press the Advanced key, then select Lock Evts. The event memoriza-
tion icon  will appear in the title bar. 

The positions memorized will then be used in the subsequent measure-
ments, either at the end of the manual acquisition, or when a stored trace 
is recalled.

The following procedure is recommended to start a measurement with 
markers:

1 Carry out an automatic measurement.

2 Memorize the position of the events selecting Lock with the key 
in the Advanced menu.

3 Add the manual measurements required (keys: Advanced > 
Manual Meas.).

CAUTION
If an event is added (with the Set Events key) after manual measure-
ments have been performed, then all the events on the trace will be con-
verted into AUTO markers and an automatic measurement will be 
performed using these events. The previous manual measurements will 
be lost.

Provided the event memorization icon  is displayed, the automatic 
measurement following the acquisition is carried out using the events 
which were present before the acquisition.

If you wish to make a measurement without events, deactivate memori-
zation of events by pressing the Free Events key.

Overlay trace
function

This very useful function enables up to eight traces to be displayed on 
the screen at once:

NOTE
This function memorizes the markers placed on the current trace.
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– either to compare traces acquired on a number of different fibers in 
the same cable, 

– or to observe changes over time in traces taken of one and the 
same fiber.

– or to compare both curves get for each way of propagation in the 
Go/Back mode.

For this purpose, the MTS/T-BERD 4000 possesses an overlay memory 
which can store:

– the current trace, defined as reference trace, for comparison with 
further traces to be acquired or loaded,

– or traces of different wavelengths for comparative purposes.

Overlaying several
traces stored in

memory

To display up to 8 traces from the memory, deleting the current trace or 
traces already loaded:

1 Press the FILE button. 

2 On the Menu/Explorer key, select Explorer.

3 Select the files of the traces for display (see "Multiple selection of 
files" page 80).

4 Press the Load key.

5 Press View trace(s) or Load Trace + Config.

6 When loading is complete, the Results screen appears: the first 
trace selected is the active trace, the other traces being overlaid.

Fig. 23 Example of overlaid traces
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Display of traces in overlay
– The traces are shown in different colors (the active trace is green).
– Their serial numbers are repeated at the top of the screen.
– The OTDR markers are referenced on the active trace by the 

symbol , and on the other traces by vertical dashes.

Adding traces in
overlay

With one or more traces already displayed, to add further traces to the 
display (the number of traces displayed cannot exceed 8):

– Define at least one trace as reference (see “Reference Trace func-
tion” on page 56)

– Press the FILE button, and in the Explorer menu, select the files of 
the traces to be added (see "Multiple selection of files" page 80).

– Press the Load or View Trace + Config key
– When loading is complete, the new traces are displayed in overlay 

with those that were defined as reference traces (see .“Reference 
Trace function” on page 56)

Swapping overlay
traces

Measurements can only be made on the active trace and not on overlaid 
traces. To make measurements on a trace in overlay, it must first be 
swapped with the active trace. To do this, press the Trace key, then the 

 and  keys, as many times as necessary, until the active trace is 
displayed in green.

Removing a trace Removing the current trace in overlay
It is possible to remove a trace displayed. To do this, first select it (see 
previous paragraph), then successively press Advanced > Overlay > 
Remove Current Trace.

Removing all the the traces in overlay
To remove all the traces except the current trace,  then successively 
press Advanced > Overlay > Remove Other Traces.

NOTE
If the number of files selected exceeds the display capacity, a mes-
sage gives warning that loading will be incomplete: only the trace or 
traces selected first will be displayed, up to the permitted limit of 8 
traces.
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Quitting the
overlay menu

To quit the overlay menu, press the Exit key. 

Reference
Trace function

The reference trace function consists in defining trace(s) which will be 
«blocked» on screen and used as models before acquiring or loading 
other standard trace(s).

Use of the
reference trace
function in the

Result page

Once one or several trace(s) is/are displayed, after an acquisition or 
loaded from the explorer:

1 If several traces are in overlay, check the correct current trace is 
selected

2 Go in the Advanced menu

3 Click on Overlay

4 Click on Set/Reset Ref. key.

The active trace becomes the reference trace; 

– its number is displayed in red 
– the icon  appears on the upper right hand part of the results 

table.

To define all the traces displayed as reference traces, click on Set/Reset 
All Ref. key (whatever is the active trace).

Removing the reference trace(s)
To change one reference trace into a «standard» trace, select it using the 
Trace/Event key, and in the Advanced > Overlay menu, click once 
again on Set/Reset Ref.

To change all the reference traces displayed into «standard» traces, 
whatever is the active trace, go in the Advanced > Overlay menu and 
click on Set/Reset All Ref..

Performing an acquisition once one or several trace(s) is/are 
defined
Three situations can occur once an acquisition is performed:

– Only reference trace(s) is/are displayed: the trace acquired is added 
to the reference ones.

– Reference trace(s) and «standard» trace(s) are displayed: the refer-
ence trace(s) are «blocked», the standard ones are removed and 
the new trace acquired is displayed with the reference one(s).

Reference trace
Active trace
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– No reference trace(s) defined: all the «standard» traces are 
removed and only the new trace acquired is displayed.

Using the
reference trace
function in the

explorer

A trace stored in memory can be set as reference trace before loading 
one or several «standard» trace(s).

To open one or several reference trace(s):

1 Go on the File Explorer

2 Select the trace(s) to be defined as reference

3 Click on Load and select Reference = Yes on the key 

4 Click on View Trace(s) or Load Trace + Config.
– The trace(s) open(s) and its/their number(s) is/are displayed in 

red 

– the icon  appears on the upper right hand part of the results 
table.

To open «standard» traces to be added to the reference ones:

1 Go back to the explorer

2 Select the trace(s) to be opened in the same screen as the refer-
ence traces

3 Click on Load and select Reference = No on the key 

4 Click on View Trace(s) or Load Trace + Config.
– The trace(s) open(s) and its/their number(s) is/are displayed in 

black  unless it is the active one

in this case, the number turns green  and 
the trace is displayed in green.

File Management

Storing OTDR
measurements

Once the measurements have been made, results can be stored on 
different storage media.

If you had entered Auto store, then the results will be saved automati-
cally.

If not, or if you want to store the results under another name, directory 
etc.:

Reference trace
Active trace

Reference trace (active)
Standard trace

Reference trace
Standard trace selected
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1 Click on the FILE key 

2 Select Setup with the key Setup/Explorer.
3 Modify the parameters you want

4 Click on Store Trace

The OTDR traces are stored with the extension ".SOR" if the line File 
type is set on Sor files. In this case, each trace will be saved in a 
different .sor file.

If in the line File Type, One msor file is selected, and if several OTDR 
traces are displayed in overlay, then one single file will be saved, with the 
.msor extension., with all the traces .

Recalling OTDR
files

Once a OTDR file has been stored, recall it using the Explorer:

1 Select Explorer with the key Setup/Explorer.
2 Using directions keys, select the directory and then the file to open

3 Click on Load
4 Click on View Tace(s) or Load Trace + Config.

The selected file is opened

For further informations on file management, see Chapter 6 “File 
management” page 69.
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Chapter 5 Power meter and Source 
options of the OTDR Modules
5

A variety of options are available when ordering an OTDR Module. 
Option:

– E41OTDRPM is the power meter option for the OTDR LM Modules
– E41OTDRLS is the Light Source option for the OTDR LM Modules.

The topics discussed in this chapter are as follows:

– “Principle of optical power and attenuation measurements” on 
page 60

– “Connection to the power meter” on page 61
– “Configuring the Power meter” on page 61
– “Display of results and commands” on page 63
– “Making a measurement” on page 65
– “Source option” on page 67
– “Storing and reloading results” on page 68
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Principle of optical power and attenuation measurements

Power
measurements

A power meter, is all that is needed to measure emitted or received 
power:

– to measure emitted power, connect the power meter directly to the 
output of the optical emitter;

– to measure the power at the input of an optical receiver, the power 
meter is connected to the end of the fiber, at the point where the 
optical receiver would be connected.

Attenuation
measurements

(optical link
loss)

For measurement of the attenuation of power in a complete link or in 
elements such as sections of fiber, connections or optical components, a 
light source and a power meter are required. 

This attenuation is usually deduced from the measurement of optical 
power at two points:

Attenuation A(dB) = P1 (dBm) - P2 (dBm)

To perform accurate measurements, the following conditions are neces-
sary

– Use a light source which is stable both in time and as a function of 
temperature.

– Make sure that all connections and fibers and the receiving cell are 
perfectly clean.

– Use a reference link between the laser source and the test subject. 
If several measurements are to be made under identical light injec-
tion conditions, this reference fiber must not be disconnected during 
the period while measurements are taking place.

Insertion loss method
1 The power meter is first connected to the laser source via the refer-

ence fiber: P1 is measured.

2 Then the fiber to be tested is inserted between the reference fiber 
and the power meter: P2 is measured.

Laser light 
source Reference 

fiber
Link under test 

Power meter of the 
MTS/T-BERD 4000

1 2
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The difference between P2 and P1 gives the attenuation of the fiber 
under test.
It is preferable to use the same type of connector at both ends of the 
fiber being tested, to ensure the same connection conditions for 
measuring P1 and P2.

Accuracy of measurements
– A high degree of accuracy is often required. It is then necessary to 

perform a preliminary calibration without the fiber under test to elim-
inate the losses due to connections as far as this is possible. To do 
this, use the «Reference Value» function.

Connection to the power meter

The type of optical connector used for the power meter is the same as 
the OTDR port.

With a module with 2 OTDR ports, select the port of connection 
according to the wavelength available at each port (a label gives informa-
tion at the back of the OTDR module).

Configuring the Power meter
The power meter function is an option chosen at the time of order and 
incorporated into the LM OTDR module in the factory.

To activate the function:

– Press the HOME button

Fig. 24 Optical connector for the Powermeter or Source on 
the OTDR Module

Connector
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– Use the direction keys to select the power meter icon in the section 
of the LM OTDR Module (framed in white)  and press the ENTER 
key : the icon is selected .

The effect of this action will to be to bring the power meter into use.

Configuring the
measurement
parameters of

the power
meter

The measurement parameters can be accessed with the SETUP key.

Wavelength Selecting wavelength:
- Auto: the wavelength of the input signal will be
automatically detected and selected to perform
the measurement:
- 1310, 1490,  1550, 1625 or 1650 nm:
measurement performed at specified
wavelength.

Beep on modulation Select if a sound must be heard when a
modulation occurs (Yes / No)

Unit Unit of power displayed:
- Watt, dBm for displaying absolute power
- dB for displaying a result relative to a reference
(link loss)

Reference level If dB units were chosen in the previous line,
selection of the reference value for the
wavelength selected. Using the direction keys,
first choose the wavelength, then press the > key
to access choice of the value (+XXX.XX), then
confirm this value with the ENTER key.
This reference is also automatically available, in
the Results page, using the Set as Reference
key.

Fig. 25 Configuration of power measurement
62 User Manual 770000102/01



Chapter 5 Power meter and Source options of the OTDR Modules
Display of results and commands

MTS4000 Module US rev01.book  Page 63  Jeudi, 26. février 2009  2:03 14
Attenuator compensation
Choice of level to be applied to the wavelength
chosen for measurement to compensate for the
loss due to the external attenuator (+XX.XX dB).
First use the direction keys to choose the
wavelength, then press > to access choice of
value, then confirm this value by pressing
ENTER.

Configuring the
alarm

parameters of
the power

meter

Alarm Activation of the Alarm function : any result below
the lower threshold or above the upper threshold
will be displayed in red on the Results page.

Min and max thresholds :
Choice of lower and upper thresholds for each
available wavelength, from -60 to +40 dBm
(selected with the direction keys).

Display of results and commands
The results page called up by the RESULTS button, gives the information 
relating to the measurement in progress, results previously saved and 
the commands available for measurement and saving.

Result of the
measurement in

progress

The power measured by the power meter is displayed in large charac-
ters, in the units selected in the SETUP menu, together with:

NOTE
To copy a Reference Level or a Attenuator Compensator on all wave-
lengths, select the reference wavelength and click on Update for All 
Wavel..

NOTE
To copy one value of the Lower or/and Upper threshold for all wave-
lengths, select the reference value and click on Update for All 
Wavel..

NOTE
A continuous push on direction keys increments the value by 10 dBm.
User Manual 770000102/01 63



Chapter 5 Power meter and Source options of the OTDR Modules
Display of results and commands

MTS4000 Module US rev01.book  Page 64  Jeudi, 26. février 2009  2:03 14
– the mode of transmission of the signal measured: continuous (CW) 
or modulated to a frequency of 270Hz, 330Hz, 1KHz, or 2KHz.

– the wavelength of the signal measured. 
– the reference level expressed in dB.
– the level of Attenuation Compensation.

Table of results For one and the same fiber, the power meter displays a table of 9 results 
corresponding to the different possible wavelengths. The first 4 results 
are displayed on the screen; to scroll through the other results, use the 
direction key . The table shows the power measured in dBm, the rela-
tive power (in dB) and the reference level in dBm (if units = dB), together 
with the mode.

– A measurement result is displayed in the table when the Keep 
Result softkey is pressed. 

– The Clear Table softkey orders deletion of all the results displayed 
in the table. 

– If the Alarm function has been activated, any result that exceeds the 
selected thresholds appears in red in the table. Otherwise, results 
are shown in the table in green.

– When the instrument is switched off, results present in the table are 
saved.

Fig. 26 Results and commands of the power meter

Results
of  the
power meter
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Commands of
the power

meter
parameters

When the Powermeter function is selected, the following softkeys are 
available on the results page:

Click on Powermeter config button to diplay the different configuration 
buttons: wavelength selection, unit choice, and zero adjustment.

Zero Adjustment of the Zero value when the power
meter’s optical input is closed with a plug (a
validation is required).

On the results page, the following actions are available:

Set as Reference Selects the current result as reference value to
measure the attenuation of a link. This reference
is displayed under the measurement result until a
new reference value is chosen.

Keep Result Saves the result on the corresponding line of the
table.

Clear Table Deletes all the results recorded in the table.

Making a measurement
The power meter is started up as soon as the function  is acti-
vated in the HOME page.

Power
measurement

– Connect the light source to be tested to the rear connector (see 
"Connection to the power meter" page 61).

– In the SETUP menu, choose the units dBm, dB or Watts.
– Press the START/STOP key to start the measurement. 

The result will appear in the results page and can be memorized in 
the table (see "Table of results" page 64).

– Press the START/STOP key to stop the measurement.

It is not possible to use simultaneously the Source function and 
the Powermeter function, when both options are set onto the 
OTDR module, as they use the same connector.

Power measurement is automatically updated in consequence. The 
value «<-50 dBm» is displayed when the laser is switched off and if 
the source output is looped on to the power meter input.
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Optical link loss

Setting the zero
value of the power

meter

1 Fix the plug over the optical input of the power meter so that no light 
can reach the photodiode of the power meter. If the zero adjustment 
is made without this plug, an error message may be displayed, as 
the photodiode will detect too much light.

2 In the Results page, press Powermeter config. > Zero soft key 
and validate.

Carrying out the
reference

measurement

1 Fix the adapter corresponding to the jumper to the optical connector 
of the power meter.

2 Connect the jumper between the input of the power meter and the 
output of the source.

3 Configure the same wavelength on the source and the power meter.
The power measured is displayed in the results page of the power 
meter.

4 Press the Set as Reference soft key to save the result displayed as 
reference value.

Measurements on
the fiber under test

After defining the reference value, proceed as follows to make the 
measurement:

1 Fix the jumpers and connectors needed to connect the fiber to be 
tested between the source output and the power meter input.

2 In the set-up menu, select dB units.

3 The power displayed in the Power Meter window corresponds to the 
optical loss of the link tested. It can be displayed in the table (see 
"Table of results" page 64).

It is important to set the zero of the power meter before making any 
measurements where accuracy is required, as the noise from the ger-
manium photodiode fluctuates over time and with variations in tem-
perature.
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Source option

Activating the
Source fonction

The Source function is an option chosen at the time of order and incor-
porated into the LM OTDR module in the factory.

To activate the function:

– Press the HOME button
– Use the direction keys to select the Source icon  in the 

section of the LM OTDR Module (framed in white)  
– Press the ENTER key

The icon is selected 

Configuring
and displaying
the parameters

of the source

Once the source icon is selected, click on the SETUP or RESULTS button 
to display the result page and to conffigure the source.

Laser On / Laser Off Activation or shut-down of the laser (same
function as the START/STOP button)

When the laser is on, the icon  is displayed.

The parameters of the source can be accessed directly on the result 
screen, by pressing the Source Config. soft key.

Wavelength To change the wavelength when a multi-
wavelength source is present (depending on
option).
The wavelength value is displayed.

Fig. 27 Configuration of the source
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Mode To vary the mode of emission of the source.
Possible modulation values are:
–  270 Hz /  330 Hz / 1 kHz / 2 kHz
– Auto (the sources emit on determined 

frequencies to enable the power meter to 
detect the wavelength used automatically)

– TwinTest (cyclical emission on all available 
wavelengths for a few seconds on each 
wavelength), compatible with the JDSU OLP 
5/6/8/55/56.

– CW (continuous emission)
The mode used is displayed, above the icon .

Storing and reloading results

File Setup Click on the button FILE to access the File setup. See the chapter «File 
management» in the user manual «4100 modules series» for a complete 
description of all parameters, options and the explorer.

Storing results In order to save the results of a measurement, click on FILE and select 
Store trace. Two files are being saved :

– The first file is to be used with the MTS/T-BERD 4000 and allows to 
retrieve all measurement results. It is saved with the extension 
«.Lts».

– The second file is a ASCII file using tabulations to separate values. 
It is saved with the extension «.txt» and can be opened by the 4000 
Platform via the Web Browser. It has been designed to be used with 
a spreadsheet program on a PC where it allows to retrieve all 
measurement results and format them in a nice customized table. 

Loading results In order to load the results of a measurement, select a file  with the 
extension «.Lts» in the file explorer (see the chapter «Chapter 6»), click 
on Load then View trace. 

The LTS tab is displayed with the loaded results in the table.
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Chapter 6 File management
6

The topics discussed in this chapter are as follows:

– “File Setup menu” on page 70
– “Explorer Function” on page 75
– “Link Manager Function” on page 84

In Home > App’s>Standalone Results > Consult Fiber Optics, the 
files can be loaded and traces can be displayed or saved even 
when no module is set into the Base Unit.
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File Setup menu

This menu is used to configure various parameters common to the whole 
of a cable.

– Press the FILE button. The following File menu appears.

Managing tabs Tabs give access to the File menu of each application (OTDR and LTS) 
present in the modules of the instrument. 

It is possible to open a file even if the corresponding module is not 
present in the instrument.. A new tab then temporarily manages this 
application.

When several different applications (corresponding to modules for 
different measurements) are managed by the Base Unit, pressing the 
FILE key several times in succession changes from one tab to another to 
give access to the file configuration of the desired application (e.g. 
OTDR, LTS etc.). See "Tabs" on page 17.

File signature The acquisition parameters of the trace contained in the selected file are 
displayed at the top of the screen together with a small-scale represen-
tation of the trace (provided it was acquired on a MTS / T-BERD) (see 
"Mini-trace" on page 17).

Fig. 28 File Setup Menu (example with OTDR file)
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File information

Rules for naming
files

In the name of the file, it is possible to program automatic inclusion of 
parameters such as the name of the fiber, identifiers (of the cable, its 
origin, its end) or the measurement parameters (direction, resolution, 
wavelength, pulse length).

The <Filenaming> line shows the current filenaming rules and can be 
used to modify them.

To edit or modify these rules:

1 Go to to the Filenaming line

2 Press  to call up the edit menu 

3 Move around in the edit screen using the direction keys

4 Select the desired characters and parameters

5 Confirm each parameter or character selected by clicking on ENTER.

6 Select Enter or Cancel to quit the edit screen (according to whether 
the modifications are to be applied or not).

Fig. 29 Example of signature of an OTDR file (in the File 
Menu)

Date of acquisition 
of the signal

Pass / Fail 
indicator

Mini-trace

Comment Acquisition time Origin / End

Refraction 
Index

Resolution

Pulse width
Laser

Module used for 
acquisition

Fiber Id
Cable Id

Fiber Number
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The key DEFAULT FILENAME is displayed when the line Filenaming is 
selected, and allows to apply the file default name to the trace opened.

Example of filenaming:

Name of a file After an acquisition, and as long as the result has not been saved, the 
line below Filenaming gives the name made up in accordance with the 
filenaming rules. 

If the file has been recalled from a memory, the line below Filenaming 
shows its name irrespective of whether it respects the current filenaming 
rules. 

This name can then be modified by calling up the edit menu using the 
button . If a modification is then made to the filenaming rules, the file 
name will not be modified. To return to a name made up in accordance 
with the filenaming rules, simply delete the existing name.

Fig. 30 Editing filenaming parameters

File parameters Filenaming rules selected Filename obtained

Resolution = 16 cm
Fiber number = 1

ABC[Resolution]Fiber_[Fiber_Code] ABC16_cmFiber_1

A file name can consist of up to 40 characters. However, beyond a 
certain length, the names will be truncated in the display on the Base 
Unit, the end being replaced by «...».
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Auto store If this option is validated, the trace or traces resulting from each acquisi-
tion are automatically saved according to the filenaming rules.

File type This line can be configured when several OTDR traces are displayed in 
overlay:

Sor files each trace will be saved, with the .sor extension.
Example: if 5 traces are displayed in overlay, and
File type is set on .sor files, than 5 files with the
extension .sor will be saved.

One msor file all the traces opened in overlay will be saved in one
single file, with the .msor extension

Dir This parameter cannot be configured, and display the directory selected 
by default into which the file(s) will be saved (the last directory selected). 
To modify the directory, go to the explorer or Link Manager page and 
select another directory.

Fiber
Description

This paragraph gives the fiber information for the extremity defined in 
Direction. If the direction is O->E, then the fiber information concerns the 
origin. If the direction is E->O, it concerns the extremity.

Fiber ID and Fiber
Number

The Fiber Id menu consists of an alphanumerical part entered by means 
of the edit menu, followed by the fiber number. This number is automati-
cally incremented or decremented as a function of the fiber code.

In Fiber Nbr, the fiber number is automatically incremented at each new 
file-save.

Editing the name enables the trace to be saved in a new file (with a 
new name), but it cannot rename the existing file (this function is pos-
sible in the Explorer menu - see "File editing function" on page 79). 
Thus the new name will not be taken into account until the trace is 
saved again.

NOTE
The information entered in the Fiber information window concerns the 
editing and/or modifications of the cable and fiber parameters. When 
a trace is recalled without recalling its configuration, the parameters of 
this trace will be present only in its signature.
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Link
description

The information entered in the Link Description window concerns the 
editing and/or the modifications of the cable and fiber parameters. When 
a trace is recalled without recall of the configuration, the parameters of 
this trace will be present only in its signature.

Cable Id This parameter allows to enter an identification of the cable, using the 
Edition menu.

Direction The direction shows if the acquisition has been made from the origin to 
the extremity (O->E) or from the extremity to the origin (E->O). Changing 
direction makes it possible, when different extremities are handled, to 
see the parameters of the fiber for the other extremity.

Origin The name of the origin of the link may be entered here.

End Location The name of the extremity of the link may be entered here.

Operator Use the arrow  to enter the name of the operator carrying out the 
measurement.

Comment In contrast to the other data in this menu, the comment is specific to a 
fiber. This line is thus used to enter a new comment and not to display it. 
The comment appears at the top of the screen, with the other parameters 
of the fiber (see figure "Example of signature of an OTDR file (in the File 
Menu)" on page 71).
This comment will remain available for the next acquisition, unless it is 
deleted. It is also saved when a trace is saved with a comment.

File export This sub-menu appears when the option <mail> has been configured 
with one media, for example Ethernet, in the System Settings menu 
(see the base manual of the Base Unit, reference 8000M02 for example.)

To send a mail, you must have filled the 2 following fields :

Mail to Use the arrow key  to enter in the edition window,
and enter the name of the recipient.

Subject Using the same key, enter the subject of the mail or
a comment if necessary.
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Buttons on the
right of the

screen

 Saving traces
Three buttons are used to save one or more traces:

– Store Trace: allows to save the current trace opened.
– Store all Traces: allows to store all the traces displayed 

in overlay (OTDR) in one single file.
– The softkey Next Trace is used to activate the menu of 

the following trace, when several OTDR traces are in 
overlay.

To copy the configuration on to all the tabs <Copy Setup for all>
The button Copy Setup For all applies the configuration modi-
fications made in the File menu displayed into the File menus 
of the other applications managed by the base (appearing in 
the other tabs).

Apply a name by default to the file
The key DEFAULT FILENAME is displayed when the line File-
naming is selected, and allows to apply the file default name to 
the trace opened.

Explorer Function
To access the Explorer function, after pressing the FILE button, 
press the Setup/Explorer/Link Mgr. key until Explorer is 
selected.

Description of
the explorer

The explorer is used to select the storage medium, and to create or 
rename directories and files:

– The left-hand part presents the storage architecture. Use the 
keys  and  to move around among all the media and their 
respective directories. 

– The right-hand part displays all the files present in the directory 
selected.

The direction keys can be used to move horizontally between the two 
parts and vertically within each zone.

At the top of the screen, the file signature selected is repeated (see 
"Example of signature of an OTDR file (in the File Menu)" on page 71).
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Storage media For saving or recalling data, the Base Unit offers a wide choice of media, 
both built-in and external.

Free space on selected media is clearly displayed at the bottom of the 
left panel.

Storage media
built into the Base

Unit

– An internal memory 
– An extended memory, on option. If this option is selected, then 

this memory replaces the internal memory when memory is full.

External USB
storage media

The Base Unit is equipped with 2 USB ports as standard. One of these 
can be used to connect an external storage medium, in particular a USB 
memory stick.

USB memory stick connection
Insert the USB memory stick in one 4000 Base Unit's USB port. 

Fig. 31 Example of explorer

Free space available 
on the selected media

NOTE
Although two USB ports are present, it is not possible to use simulta-
neously more than one external USB storage medium.

High capacity USB sticks of 2Go or higher which have not been deliv-
ered by JDSU are not recommended.
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A beep is emitted to confirm the successful insertion and recognition 
of a USB memory stick.
Then, the icon , is displayed in the upper banner to inform the 
user the USB stick is ready to be used.

Do not connect a USB memory stick while a USB printer is printing.

If the 4000 Base Unit does not emit a beep, disconnect and reconnect 
the USB memory stick (do not perform this action too quickly - wait 5 
seconds between the disconnection and reconnection).

If after several trials, the USB key is not displayed in the Explorer page, 
two problems can be considered:

– A previous USB memory stick has not been properly disconnected. 
Go to “USB memory stick disconnection” on page 78

– the USB memory stick is not detected by the Base Unit: use another 
USB memory stick or transfer data via Ethernet (see user manual of 
the 4000 Base Unit to access the internal memory via a PC).

In case of errors, the icon  is displayed:

– The stick is not formatted
– The stick has been removed without prior EJECT USB key use and 

some applications are still using it.

If  the size of the free space is not correct, the USB memory stick must 
be formatted:

a Press the HOME button

b Successively select Expert Tools>Media Utilities>Usbflash 
Format

c Confirm your choice to format the USB memory stick

d Once formatted, disconnect and reconnect the USB memory 
stick

As for any media formatting, please note that all data present on 
the USB memory stick will be irremediably lost.

When a file is moved in the explorer of the Base Unit, the end of 
the move on the screen does not mean that writing of data into 
the memory is complete. Some data may still be in a writing 
process if the storage unit is removed prematurely. 
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USB memory stick disconnection
Before disconnecting the USB memory stick, always select a storage 
device different from usbflash (select disk for example) in the explorer. 

Make sure you no longer have any running applications using the 
usbflash storage media. 

The user must push the EJECT USB key, which is available in File > 
Explorer or Link Manager, but also in Expert Tools > Media Utilities.

The icon becomes  to indicate it can be removed safely. In this state, 
the USB stick cannot be used anymore.

The USB memory stick can then be disconnected from the Base Unit's 
USB port.

The disconnection of the USB memory stick produces one beep. 

Abbreviations for
storage media

The abbreviations used in the explorer for the different storage media 
are:

Directory edit
function

The editing functions are similar to those of other explorers. The directo-
ries are at the top left of the screen. If the cursor is in this part, the func-
tions proposed by the keys are specific to the management of the 
directories.

NOTE
If the Base Unit operates on battery and is switched off before the 
USB memory stick is properly disconnected, all the applications using 
the usbflash storage media will be automatically turned off and the 
USB memory stick can be disconnected afterwards without any prob-
lem.

NOTE
If the 4000 Base Unit is on mains and is switched off before the USB 
memory stick is properly disconnected, the Base Unit needs to be 
completely switched off (using the ON/OFF button and main plug 
unplugged).

Abbreviation Storage medium

disk Internal memory

extmem Internal memory extension

usbflash USB memory stick
78 User Manual 770000102/01



Chapter 6 File management
Explorer Function

MTS4000 Module US rev01.book  Page 79  Jeudi, 26. février 2009  2:03 14
Selection of
directories

If the cursor is in the left-hand part of the screen:

– the direction keys can be used to select a directory. 
– the ENTER key opens the directory selected and closes it when 

pressed a second time.

Edition of
directories

When a directory is selected, the keys offer the following functions:

Create Directory Creation of a new directory. An editor enables entry
of its name.

Rename Dir. Renames the directory selected. An editor enables
replacement of its current name.

Edit Opens a new menu providing functions for editing
the directories: Copy, Cut, Paste, Delete.

File editing
function

The right-hand part of the screen can be used to work on the files in the 
directory selected. A table gives the list of the files in the directory, 
showing for each one: its name, size, type and date of creation.For files 
recognized by the Base Unit, the types are symbolized by icons.

Do not confuse "Selected" with "Active". A directory may be displayed 
in video inverse, to show that it is the current working directory. If it 
does not have a broken red line round it, it is not active.

Fig. 32 Selected / Active File

Active: working directory Selected: the cursor is here

NOTE
A whole directory with its contents can be copied into another direc-
tory or on to another storage medium.

Icon Type of FO file

OTDR file (.SOR extension)
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Format of files – OTDR files that can be read by the Base Unit are type Bellcore 1.0, 
1.1 and 2.0.

– The PDF files are opened via the PDF viewer (see «PDF Viewer» in 
te User Manual of the 4000 Base Unit).

– The HTML and TXT files are openend via the Web Browser (see 
«Web Browser» in the User Manual of the 4000 Base Unit).

– To read other formats, use FiberTrace, or FiberCable JDSU 
softwares

Easy file selection The direction keys are used to position the cursor on the file to be 
selected.

Multiple selection
of files

It is possible to select several files simultaneously to move them, delete, 
print, or copy them on to another medium or to display the corresponding 
traces in overlay (see "Display of several traces in overlay" on page 83). 

To do this, press ENTER after each selection. The files selected appear 
in video inverse. To deselect a file, place the cursor on the name of the 
file and press the key ENTER again.

Power Meter file (.LTS extension)

Icon Type of file

HTML file (.HTML extension)

PDF File (.PDF extension)

Text file (.TXT extension)

License file (.LIC extension)

Icon Type of FO file

With the 4000 Platform, you can open and load any kind of file 
(OTDR & LTS) even if the corresponding modules are not usable 
with the Platform.
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To select a list of files using the keys of the Platform:

1 Select and validate the first file of the list (red display)

2 Set the cursor on the last file of the list (blue display)

3 Press the right direction key  to select all the files from the list

Commands
relating to files

When a file is selected, the keys offer the following functions:

Load Opens the sub-menu for display of traces. See chapter 
"Loading files and displaying traces" on page 83

Select all Direct selection of all the files in the directory. After this
key has been pressed, its name changes to <Deselect
All> so that the operation can be cancelled if necessary.

Edit Displays a sub-menu to copy, cut, paste, delete,
rename or merge one or more files.

Using the Merge key, with the txt files.
When saving a LTS measurement result, in addition to the .LTS file, a txt 
file is automatically saved for each measurement type.

The key Merge is used to merge several txt files from LTS measure-
ments into 1 txt file, putting together the results of both files.

– In the explorer, select the txt files generated with the LTS you want.

NOTE
If a mouse is used, click on a file to select it, and click again to dese-
lect it.

Fig. 33 List of files selected

If no file has been selected by the ENTER key, the file where the cur-
sor is positioned is taken as selected.

On the other hand, if a file has been selected with the ENTER key, and 
the cursor is on another file, the latter is not selected!
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– Click on Merge key
The file merged_files.txt is automatically saved in the same directory 
as the one where the LTS txt files have been selected.

Sort Opens a sub-menu with which the files in the
directory can be sorted by name, size, type or date.

Send by mail This option appears if <Mail> has been defined with
a media in the system setup menu. The subject and
the recipient of the mail are those set in the file setup
menu (see "File export" on page 74). Comments
may be added. This option allows to send files by e-
mail. After a few seconds, a message is displayed to
inform the user that the mail has been sent
successfully.

Saving Files
from the
Explorer

When the explorer is displayed, the active trace for the selected tab is 
displayed in the File Signature.

You can then save the active trace:

1 Select a directory by clicking once on it

2 Click on Store to save the active trace or click on Next Trace to 
change the file signature on the top part of the screen and to save 
the next trace from traces in overlay

3 Click on Store.

4 If you wish, click on FILE button to display the Explorer page for 
another application and save, using the same method, the active 
trace from this application.

This will open automatically the edition keypad, in order to give a 
filename for the active trace.

NOTE
The file merged_files.txt can be renamed once it is saved.

Fig. 34 Saving active trace from the explorer

The trace dexcribed in the file si-
gnature will be saved in the direc-

tory selected (in this example:
Demo Curves)

Displayed when two active 
overlaid traces are open.
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Loading files
and displaying

traces

To access the functions for loading one or more files, select the file(s) in 
the explorer and press Load. Several options are then available: 

Simple loading The key View Trace(s) enables simple loading of traces, using the 
current parameters of the Base Unit. The current trace is then replaced 
with this new trace.

Load with
configuration

The key Load Trace+Config will display the traces, recalling the config-
uration recorded in the file. Thus the zooms, cursors and parameters 
present at the time of acquisition will be used for the display. 

This function also enables to recall and set the parameters defined in the 
screens corresponding respectively to the FILE and SETUP keys.

It is then possible to perform an acquisition under the same conditions as 
those of the trace recalled.

– If the Base Unit was equipped with a different module from the 
current one when the trace was acquired, certain configuration 
parameters cannot be updated. A message warns the user of this.

– If several traces are selected, the configuration used will be that of 
the first trace.

– If the number of traces added and the number of traces present is 
greater than 8, then the last traces added will not all be taken into 
account.

Load Trace + Info
(with OTDR files

only)

The OTDR traces can also be loaded without the parameters defined in 
the screen displayed via the SETUP key.

The key LOAD TRACE + INFO will then display the OTDR traces, recalling 
exclusively the File information, such as the fiber name and number, 
direction, extremities etc. See Figure 28 on page 70.

Display of several
traces in overlay

Up to 8 traces in the same application (OTDR) can be displayed simulta-
neously in overlay. 

The configuration cannot be recalled if the trace was not originally 
created by a MTS/T-BERD 4000.
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To obtain a display of multiple traces, two methods are possible:

– Select all the files to be loaded at the same time (see chapter 
"Multiple selection of files" on page 80) and click on Load

– Define a reference trace in a first time, open it, then come back 
to the explorer to select the other traces to be added (see 
“Reference Trace function” on page 56).

Link Manager Function
The Link Manager function is available using the LINK MGR. key and 
allows to display the explorer with all the link information for the active 
application.

Click as many times as necessary on the key MENU / EXPLORER / LINK 
MGR.to select FIBER INFO. and display the corresponding files for the 
active tab.

For example, if the Link Mgr. function is selected in the tab OTDR, only 
the link information from the OTDR files will be displayed.

According to the application selected, the fiber information available are 
different. The table below describes the fiber information displayed for 
the OTDR files:

NOTE
The Fiber Info. function is only available with the OTDR files

Fig. 35 Link Manager. function (with OTDR files only)

Tab
selected
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Editing function The same editing functions as those from the Explorer are available with 
the Link Manager function:

– Directory: Copy (or cut) / Paste; Delete, (see “Directory edit func-
tion” on page 78)

– File(s): Copy / Cut, Rename, Paste, Delete (see “File editing func-
tion” on page 79) except the merging function (as this is used with 
txt files).

Moreover, the Edit menu from the Fiber Info. function allows to export the 
whole directory, with the files corresponding to the active tab, in a txt file.

To export a directory:
1 Select the LINK MANAGER function

2 Select the tab corresponding to the files you want to use

3 Select the directory to open

4 Select one file from the list

5 Click on EDIT > EXPORT

The txt file is automatically generated, in the same directory as the 
one selected for the export.

NOTE
The files in the Link Manager window can be sorted according each 
column available for a tab.

Table 1 Fiber Information displayed

Param. OTDR

1st Alarm status (icon) & Fiber number

2nd Direction

3rd Lambda

4th Total Loss

5th Fiber Length

6th Nb of Event

7th Max Splice

8th Total ORL
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The name by default for the txt file is: fiber_info_”name of applica-
tion selected”.txt. For example, for the export of the Fiber Informa-
tion from the OTDR application, the txt file will be called: 
fiber_info_otdr.txt

This txt file can be openend via the Web Browser on the 4000 Platform, 
or using a spreadsheet program onto a PC (e.g. Excel).

This txt file is made of two parts:

– The Header, with general information: the equipment used and its 
serial number, the date and time of export, the location of the file, 
and the number of files exported.

– The table, countaining all the fibers information coming from the files 
of the active tab.

Fig. 36 Exemple of a directory exported in a txt file (open 
with Excel)

Header of 
the txt file

Recall of the Fiber In-
formation displayed on 

the 4000 Base Unit 
(except alarm status)

Filename
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Chapter 7 Macros
7

The macro function allows to store series of user actions, in order to play 
them back automatically.

The macro function is operational only while the Base Unit is used under 
the context of «fiber optic applications», meaning used with one of the 
following application selected: OTDR, LTS... 

A file macro may also be operational with no active modules, as long as 
«Standalone results» for fiber optics is used, and concerned files are 
fiber optics files.

The topics discussed in this chapter are as follows:

– “Calling the Macro function” on page 88
– “Macro recording” on page 88
– “Default macro” on page 91
– “Macro playback” on page 92
– “Storing a macro” on page 93

Actions in the HOME page will not be recorded.
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Calling the Macro function
This function is accessible via the button AUTO, in the front of the Base 
Unit.

10 various macros may be created and used.

Once you click on the button AUTO, you see the list of all the 10 macro 
positions. Each number from 1 to 10, displays the name of the macro 
stored at that position, or displays «(Empty)» in case that particular spot 
is free.

Macro recording
The Base Unit offers two different types of macro: Standard and File. 

For both types, it is required to:

Select and activate all necessary modules before starting the macro 
recording

Standard macro This macro type shall be used to automate functions or operation mode.

Fig. 37 List of Macros

Never press the HOME key during macro recording
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To create a new standard macro:

1 Select a free position. A sub-menu automatically appears.

2 Change the Macro type if necessary to set it on Standard.

3 Click on the soft key Learn. You arrive directly to the Results page. 
You can now see the icon at the top of the screen. You are 
now ready to record.

4 Perform all actions you wish to record in your macro.

5 Click on AUTO when you are done, and select End Macro. You 
macro has now been saved. 

6 Enter the name of your new macro in the text editor and confirm.

File macro This macro type shall be used to perform a template for multiple files.

To create a new file macro:

1 Select a free position. A sub-menu automatically appears.

2 Change the Macro type if necessary to set it on File.

3 Click on the soft key Learn. 
You arrive directly to the FILE page, the icon  is displayed on 
the upper banner

4 Select the file you want to work with to perform all actions.

5 Load and view the corresponding trace. You can now see the icon 
at the top of the screen, indicating you are ready now to 

record.

6 Perform all actions you wish to record in your macro.

7 Click on  AUTO when you are done, and select End Macro. You 
macro has now been saved. 

8 Enter the name of your new macro in the text editor and confirm.

Notes for standard macros also apply for file macros.

NOTE
All events are recorded wether you use the Base Unit buttons, the soft 
keys, the touchscreen, a mouse, or an external keyboard.

NOTE
The speed of your actions is not really relevant. See "Macro playback" 
page 92
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Adding
interaction to

your macro

You may insert in your macro, a special dialog box, a message or a 
pause. These features will be very useful to you. They will give you some 
time to switch to another fiber if necessary, let you play a macro to a 
partial state and stop, or simply just bring your attention after or before a 
specific action is performed.

To access all these features, click on AUTO during the learning process 
of a macro, just like if it was done. Several soft keys will become avail-
able.

Inserting a dialog
box

Click on the soft key Insert Dialog Box. The dialog box editor is 
displayed. Enter the content of your dialog box and press confirm when 
you are done.

Inserting a
message

Click on the soft key Insert Message. The Message text editor is 
displayed. Enter the content of your message and press confirm when 
you are done.

Inserting a pause Click on the soft key Insert Pause. This action will automatically make 
the macro wait for a user action. 

Renaming a
macro

Whether you just created a new macro or you wish to modify the name 
of an existing macro, you may edit the name and change it as much as 
you want.

1 Select the macro and select Name on the sub-menu. 

2 Click on  to open the text editor, and type your name.

3 Click on Confirm to accept your new name.

NOTE
Dialog boxes and messages serve different purposes when the macro 
is played back. A message will just appear to bring your attention to a 
specific point and wait until you are ready to continue. A dialog box 
will give you the choice between continuing to play the macro, or 
aborting it, letting you partially play a macro in some cases.

NOTE
During playback, you can see the icon  when a pause is encoun-
tered. Press any key to restart the playback.
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The «Overwrite
Config.» setting

Both your actions and the actual configuration are saved when you 
create a new macro. So when you play a macro back, you have the 
choice between:

1 Playing all actions and keeping the actual configuration

Your actions are fairly independent of the configuration, and you don’t 
wish to modify the current configuration: set Overwrite Config. on No.

2 Playing all actions and restoring the original configuration

Your actions are very dependant of the configuration, for example in case 
you need to do some measurements where you wish to keep all the 
acquisition parameters the same: set Overwrite Config. on Yes. This 
setting will also allow to make sure all necessary modules are selected 
in the HOME page before the macro is started.

Replacing a
macro

Select an existing macro and click on the soft key Learn.

A message will be displayed, asking you if you really wish to overwrite 
the macro. Click Yes if you wish to continue.

Removing a
macro

Select an existing macro and click on the soft key Remove.

A message will be displayed, asking you if you really wish to delete the 
selected macro. Click Yes if you wish to continue.

Default macro

How to use the
default macro

It is possible to set one macro as default. This is very useful if for 
example, you wish to perform one macro several times in a row. Click 
twice on the button AUTO will automatically play the default macro.

How to set a
macro as

default

Select Default Macro, and choose in the sub-menu, which macro you 
wish to set as default.

As an alternative, you may also select a macro and press the soft key Set 
as default. 

It is strongly recommended to use the second method where all con-
figuration is restored before playing the macro. Only experienced 
users might decide to do otherwise for different reasons.
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Macro playback
To play the default macro, click on AUTO twice.

To play another macro, go to the macro screen (click on AUTO), and 
select the macro you wish to play. Then press the soft key Play.

During all the play back of the macro, you can see the icon  at the 
top of the screen.

All actions recorded in your macro are now performed.

The speed of the playback is not the same as the speed of the record-
ing. All actions except for acquisitions, will appear faster, but will remain 
slow enough to let you see what is currently performed. Acquisition 
times remain the same as during the recording.

Fig. 38 Default button

Macro 2 is set as default

Alternatively, set any other macro 
as default using this button

NOTE
This icon changes to  when the playback is suspended by a 
pause event, waiting for the user to restart the process (see "Inserting 
a pause" page 90).

NOTE
Don’t forget to add interactive events during your macro recording if 
you need a pause, a specific message or simply to be able to abort 
the macro at a certain stage if necessary.
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.

Storing a macro
The Base Unit lets you save macros as files on the hard disk or other 
storage media.

To store a macro, select it and click on the soft key Store. It will automat-
ically store it in the current directory, and represented by the icon .

To reload this macro later on, go to the file explorer and load the file. The 
macro will automatically take the first available place in the list of your 10 
macros.

Touching a button on the Base Unit will automatically cause the macro 
playback to abort, except for restarting the playback, interrupted by a 
pause event.

NOTE
For a File macro, you may select several files before you call the 
Macro function.

NOTE
If you wish to store your macro at a specific place on your storage 
media, make sure you use the file explorer to set that place as your 
current directory.

The macro cannot be loaded if no macro position is available.
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Chapter 8 Technical specifications
8

This chapter shows the technical specifications of the OTDR modules 
and of the options available for the MTS/T-BERD 4000, .

The topics discussed in this chapter are as follows:

– “Reflectometer modules” on page 96
– “Technical specifications of the Power meter” on page 98
– “Technical specifications of the Source” on page 99
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Reflectometer modules

Characteristics
of reflectometry
measurements

Measurement of
distance

– Dual cursor 
– Distance displayed takes into account the calibration of the refrac-

tive index of the fiber.
– Index adjustable from 1,30000 to 1,70000 in steps of 0,00001
– Resolution of display : 1 cm max.
– Resolution of cursor : 1 cm max.
– Spacing of measurement points: from 4 cm, with up to 128 000 

acquisition points .
– Accuracy : ± 1m± sampling resolution ±10-5 x distance

(excluding errors of calibration of refractive index of the fiber).
– Display span: 2.6 m to 260 km

Measurement of
attenuation

– Dual cursor
– Resolution of display: 0,001 dB
– Resolution of cursor : 0,001 dB
– Linearity : ± 0.05 dB/dB
– Display span: 1.25 dB to 55 dB

Measurement of
reflectance

– Resolution of display: 0,01 dB
– Accuracy : ± 2 dB

Automatic
measurement

– Automatic measurement of all the elements of the signal. Slope 
measurement by least squares or 2 points of measurement.

– Display threshold of faults :
- 0 to 5.99 dB in steps of 0.01 dB for event thresholds 
- 11 to -99 dB in steps of 1 dB for the reflectance
- 0.01 to 5.99 dB in steps of 0.01 dB for attenuation

– Display of slope and attenuation for a segment of fiber.
– Display of the position of a fault and of attenuation.
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– Display of the reflectance of the fault.
– Display of ORL

Manual
Measurement

– Measurement of slope between the cursors.
– Measurement of attenuation between two segments of fiber.
– Measurement of reflectance of a reflecting element.
– Measurement of ORL between the two cursors.
– Measurement of splice by 2 or 5 points method 

Typical
specifications

of OTDR
modules

The specifications provided below are valid wathever the wavelength 
configuration (single, dual, triple wavelength).

Typical values, measured at 25°C unless specified

Monomode

Central Wavelengtha 1310 nm
± 20 nm

1550  nm
± 20 nm

1625 nm
± 10 nm

1650 nm
± 20 nm

min IEC Dynamicb 27.5 dB 25 dB 25 dB 23.5 dB
Typical RMS Dynamic 
Rangec 32 dB 30 dB 30 dB 28 dB

Distance Range up to 160 km up to 160 km up to 160 km up to 160 km
Pulse width 3 ns to 10 µs 3 ns to 10 µs 3 ns to 10 µs 3 ns to 10 µs
Event Dead Zoned 1 m 1.1 m 1.1 m 1 m
Attenuation Dead 
Zonee 4 m 4 m 4 m 4 m

a. Laser at 10 µs and 25° C
b. Guaranteed value corresponding to the  one-way difference between the extrapolated backscattering level at the 

start of the fiber and the level countaining 98% of noise, after 3 minutes of averaging, with the largest pulsewidth 
(according to IEC 61749 standard).

c. The one-way difference between the extrapolated backscattering level at the start of the fiber and the RMS noise 
level, after 3 minutes averaging and with a high dynamic resolution.

d. At 1.5dB from peak value of a -27dB reflective event.
e. At ± 0.5 dB from the linear regression using an -55dB reflective event.
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Ranges

Class of the
lasers of the

OTDR modules

OTDR modules
measurement

Weight : approx. 300 g (0,66 lbs)

Dimensions (in mm) - w x h x d: 128 x 134 x 41

Technical specifications of the Power meter
Specifications given for 25°C, after 20 minutes stabilization time and after 
zero setting.

– Measurement Wavelength: 1310, 1490, 1550, 1625, 1650 nm
– Calibrated wavelengths: 1310 / 1550 / 1625 / 1650 nm
– Accuracy at calibrated wavelengths: ± 0.5 dB (at -30 dBm)
– Input power range: - 50 to - 2 dBm
– Maximum resolution: 0.01 dB / 0.01nW
– Measurement range:- 45 to - 5 dBm 
– Linearity within the measurement range: ± 0.5 dB

3 ns 10 ns 30 ns 100 ns 300 ns 1 µs 3 µs 10 µs

1 km x x x
2 km x x x x
5 km x x x x x
10 km x x x x x x
20 km x x x x x x x
40 km x x x x x x x
80 km x x x x x x
160 km x x x x

Module Standard FDA21CFR§1040.10
Singlemode LM Class 1
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Technical specifications of the Source
– Laser Class 1 
– Wavelength lasers at 25°C:

– 1310 ± 20 nm
– 1550 ± 20 nm
– 1625 ± 20 nm
– 1650 ± 20 nm
The wavelengths available for the source are the same as those 
available for the OTDR module.

– Spectral bandwidth: 5 nm RMS typical

Output level
– - 3.5 dBm typical
– modulated mean level: - 6.5 dBm typical

Emission mode
– Continuous signal (CW)
– Signal including lambda information for the power meter (Auto).
– Modulated signal to identify the fiber (at 270, 330, 1k or 2kHz).
– Wavelengths activated one after the other (TwinTest mode).
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Chapter 9 Options and accessories
9

This chapter shows the references of the options and accessories for the 
modules of the MTS/T-BERD 4000.

The topics discussed in this chapter are as follows:

– “References of measurement modules” on page 102
– “User manual references” on page 102
– “References of optical connectors and adapters” on page 103
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References of measurement modules

OTDR Modules1 Singlemode Module

Options

User manual references

1. Supplied with its manual on USB key
Specify optical connector of each OTDR ports

Modules Reference

Last Mile OTDR 1310/1550 nm Module E4126LM

Last Mile OTDR 1310/1550/1625 nm Module E4136LM

Last Mile OTDR 1310/1550/1650 nm Module E4138LM65

Last Mile OTDR 1310/1550 nm & 1625F nm Module E4136RLM

Last Mile OTDR 1625 nm Module E4117LM

Last Mile OTDR 1650 nm Module E4118LM65

Last Mile OTDR 1650F nm Module E4118RLM65

Dummy Module Reference

Additional dummy module for MTS/T-BERD 4000 40EMPTYMOD

Modules Reference

Power meter option for LM OTDR modules E41OTDRPM

Light source option for LM OTDR modules E41OTDRLS

User manuals for MTS/T-BERD modules Reference

Printed user manual for 4100 OTDR modules (French) E4100M01

Printed user manual for 4100 OTDR modules (English) E4100M02

Printed user manual for 4100 OTDR modules (German) E4100M03
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References of optical connectors and adapters

NOTE
A USB key is delivered, with all the manuals in pdf format.

The printed versions are available on option, in French, English or 
German.

Front Panel Optical Connectors for modulesa

Single-mode Universal OTDR Reference

Universal PC Connector with FC adapter EUNIPCFC

Universal PC Connector with SC adapter EUNIPCSC

Universal PC Connector with ST adapter EUNIPCST

Universal PC Connector with DIN adapter EUNIPCDIN

Universal PC Connector with LC adapter EUNIPCLC

Universal APC Connector for SM only with FC adapter EUNIAPCFC

Universal APC Connector for SM only with SC adapter EUNIAPCSC

Universal APC Connector for SM only with ST adapter EUNIAPCST

Universal APC Connector for SM only with DIN adapter EUNIAPCDIN

Universal APC Connector for SM only with LC adapter EUNIAPCLC

a. A connector (universal) must be specified at time of order of the module

 Additional Adapters for Universal Connectorsa Reference

Universal FC Adapter EUFCAD

Universal SC Adapter EUSCAD

Universal ST Adapter EUSTAD

Universal DIN Adapter EUDINAD

Universal LC adapter EULCAD

a. Interchangeable in the field
User Manual 770000102/01 103



Chapter 9 Options and accessories
References of optical connectors and adapters

MTS4000 Module US rev01.book  Page 104  Jeudi, 26. février 2009  2:03 14
104 User Manual 770000102/01



MTS4000 Module US rev01.book  Page 105  Jeudi, 26. février 2009  2:03 14
Index
A
Accessories 101
Acquisition time 28
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reference 103
switch 6
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Alarms 32
Attenuation 46, 60

specifications 96

B
Backscatter coefficient 3
Bend 30

C
Coefficient of reflection 3, 4
Connection

quality 33
Connectors 6

cleaning 7
references 103

Construction 27
Construction mode 39

Cursor
movement 22
resolution 96

D
Distance

specif. OTDR measurement 96

E
Entire trace

display 23
Event

macro 89, 92
Event memorization 53
Event OTDR 43, 44, 46, 48

icons 46
External Keyboard 19

F
Fault Locator 28

acquisition 36
Bend 42
principle 36
summary 46
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Fault locator
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Fiber end 30
File

edition 81
expedition 74
fiber description 73
loading 83
multi-selection 80
naming 71
save 82
signature 70
types 79, 80

File Explorer 75
File setup menu 70

G
Ghost 29, 46

I
IOR 30

specifications 96

K
Keys description 18

L
Laser 28
Laser classes 98
Launch cable 31, 46
Link manager 84
LTS

store 68

M
Macro

adding interaction 90
calling 88
Default 91
File 89

overwrite 91
Playback 92
recording 88
renaming 90
Standard 88

Mail
file expedition 74

Measurement
attenuation measurement 60
distance (specif.) 96
optical link loss 60
power measurement 60
reflectance (specif.) 96

Multi-wavelength acquisition 35, 
38, 40

O
ORL 52

saturated trace 53
OTDR

acquisition parameters 27
Configuration 26
manual measurement

2 points 51
5 points 51
ORL 52
slope 49, 50
splice and reflectance 51

manual measurements 49
measurement parameters 29
module references 102
options references 102
principle of measurement 2
Real time acquisition 34
real time acquisition 34
results display 32
results parameters 31
selection 26
specif. measurement 96

OTDR Events
delete 49
hints 49
representation 48

OTDR module
size 98

OTDR ranges 98
OTDR trace

store 57
Overlay traces
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P
Power meter

alarms 63
attenuator 63
configuration 61, 62
connection 61
measurement 66
measurement process 65
reference measurement 66
results 63
specifications 98
zero value 66

Pulse 28

Q
Quick Link Test 27, 37

R
Range 28
Reference trace 56
References 101
Reflectance 46

definition 3
specifications 96

Resolution 28

S
Scatter coefficient 31

Shift function 23
Slope 46, 49
Software update 7

by Ethernet 10
by PC 8
by USB memory stick 11

Source
display 67
specifications 99

Source option 67
Specifications 95
Splice 51

T
Trace

results 21
Traffic Detection 32

U
Units 32
USB memory stick use 76
User manual

references 102

V
Virtual bar 19

Z
Zero value 66
Zoom 22
Zoom Auto 23
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